Oracle Financials Cloud
Creating Analytics and Reports for Financials

19C
# Contents

## Preface

### 1 Introduction to Financial Reporting

- Overview of Creating Financial Analytics and Reports
- Overview of Financial Reporting Center
- Overview of Reports and Analytics Tools
- Financials Reports and Analytics Pane
- Where to Save Analytics and Reports
- Business Intelligence Catalog

### 2 Analytics

- Oracle Transactional Business Intelligence for Financials
- Explore Financial Subject Areas in Oracle Transactional Business Intelligence
- Overview of Analytics Creation and Modification
- Create and Edit Analyses Using a Wizard
- Create and Edit a Financial Analysis Using a Wizard
- Manage Analytics with Advanced Features
- Add an Analysis to the Project Performance Dashboard
- Create and Edit Dashboards
- Copy the Payables Invoice Audit Listing Dashboard
- Repository and Session Variables for Business Intelligence
- FAQs

### 3 Subject Areas for Analytics

- How Data Is Structured for Analytics
- Financials Data Structure for Analytics

### 4 Reports

- Overview of Oracle BI Publisher Best Practices for SaaS Environments
- Configure Reports
- Templates
- Configure Email Notifications
5 General Ledger Reports 73

- Considerations for Implementing Financial Reporting Center 73
- Set Up Financial Reporting Center and Smart View 73
- Smart View 76
- Create Financial Reports 82
- Configure an Account Group 97
- FAQs 100
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help

Use help icons to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community**: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- **Guides and Videos**: Go to the Oracle Help Center to find guides and videos.

- **Training**: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Introduction to Financial Reporting

Overview of Creating Financial Analytics and Reports

Oracle Financials Cloud provides predefined analyses, dashboards, and reports that help you meet financial and business intelligence requirements. With the many reporting tools, you can run, view, and build user-defined or real-time analytics and reports.

The Oracle Financials Cloud: Creating Analytics and Reports Guide covers creating and editing analysis and reports as well as subject areas for the following Oracle Fusion Financial Applications:

- General Ledger
- Intercompany
- Budgetary Control
- Subledger Accounting
- Payables
- Payments
- Cash Management
- Expense Reporting
- Assets
- Receivables
- Collections

Configuring Analytics and Reports

You can create and edit analytics and reports for your own use. Or, if you have the appropriate roles, you can configure for others. For example, you can:

- Add or remove columns from an analysis.
- Change the branding logo on report output.
- Create a dashboard to include your most commonly viewed analyses.

Setup and Administration

Additional tasks support creating and editing analytics and reports. For example, your implementor or administrator can:

- Secure access to user-defined analytics and reports.
- Archive and move user-defined analytics and reports from one environment to another.
- Create financial report definitions.
Overview of Financial Reporting Center

The Financial Reporting Center is intended to be the primary user interface for financials end users to access all seven report types.

Financial Reporting Center

The Financial Reporting Center includes these report types: Financial Reporting Studio Reports, Account Groups and Sunburst, Smart View Reports, Oracle Transactional Business Intelligence Analyses, Oracle Transactional Business Intelligence Dashboards, Oracle Business Intelligence Publisher Reports, and Business Intelligence Mobile Apps. Other reporting tools are also available to run the same seven report types.

The following figure illustrates the report types that are available in the Financial Reporting Center.

Reports can be accessed through various methods. However, the Financial Reporting Center provides access to every type of report, is intended to be the primary user interface for financials end users, and is tablet and smartphone friendly. In addition to accessing reports, you can add favorites, define tags, and view report details, such as type and last updated date.
Financial Reports are read from the Shared > Custom > Financials and My Folders directories. All other report types can be saved anywhere in the BI Catalog however, any user-defined content should be in the Shared > Custom folder. Subfolders can be created within the Shared > Custom folder.

Seven types of reports can be run from the Financial Reporting Center and from the other reporting tools.

- Financial Reports: These reports are built off of the Oracle Financial Reporting Studio using data in the Oracle Fusion General Ledger balances cube. For example, company income statements and balance sheets. These reports are mainly run by users in General Ledger.
- Account Groups and Sunburst: Account groups are used to monitor key accounts in General Ledger. When a user creates an account group, it becomes visible in the Financial Reporting Center with the Sunburst visualization tool. The Sunburst visualization tool lets you interact with your account balances across various business dimensions to view balances from different perspectives. Account groups are used only in General Ledger.
- Smart View Reports: Smart View is a multidimensional pivot analysis tool combined with full Excel functionality. Smart View enables you to interactively analyze your balances and define reports using a familiar spreadsheet environment. These queries are mainly for users in General Ledger. To share Smart View queries, users can email them to other users, or they can upload the queries to the Financial Reporting Center where users can download them to a local drive for use. The Financial Reporting Center is only a place for users to upload and download Smart View queries.

  **Note:** To upload a Smart View report to the Financial Reporting Center: select the Open Workspace for Financial Reports task, navigate to the BI Catalog, and select Upload from the Tasks section. Be sure to upload the Excel file to one of the folder locations mentioned previously.

- Oracle Transactional Business Intelligence Analyses: These analyses and reports are built off of transactional tables using subject areas. These reports can be run by users in General Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.
- Oracle Transactional Business Intelligence Dashboards: Dashboards put all the information, functions, and actions that a business user must have to do their job in one place. Dashboards are built off of Oracle Transactional Business Intelligence objects like analyses and reports. These reports can be run by users in General Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.
- Oracle Business Intelligence Publisher Reports: Most of these reports are predefined and must first be submitted and resubmitted to see the latest data by the Oracle Enterprise Scheduler through the Scheduled Processes navigation. These reports can be run by users in General Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.
- BI Mobile Apps: Oracle Business Intelligence Mobile App Designer is an application that enables you to create multitouch information-driven applications with rich interaction, rich visualization, and rich media, for mobile devices such as iPhone, iPad, Android phone, tablet, and more. These reports can be run by users in General Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.

**Other Reporting Tools**

Six other tools are available for reporting in Financials.

The following table lists the other reporting tools and the types of reports they support.

<table>
<thead>
<tr>
<th>Other Reporting Tools</th>
<th>Report Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Accounting Dashboard and Account Inspector</td>
<td>Account Groups</td>
</tr>
</tbody>
</table>
Other Reporting Tools | Report Type
---|---
Reports and Analytics | Oracle Transactional Business Intelligence Objects

BI Catalog | All Report Types, Except Oracle Business Intelligence Publisher Reports


Enterprise Scheduler System | Oracle Business Intelligence Publisher Reports

Even though the Financial Reporting Center is designed to be the main user interface for a financial end user’s reporting needs, some users may choose to use any of the six other tools for reporting in financials, such as:

- **General Accounting Dashboard**, which provides access to Account Groups: Uses the Account Monitor to efficiently monitor and track key account balances in real time.
- **Account Inspector**: Perform ad hoc queries from account groups and financial reports through drill down to underlying journals and subledger transactions.
- **Reports and Analytics**: This reporting tool has a panel that reflects the folder structure of the BI Catalog. Users can access and run any Oracle Transactional Business Intelligence analysis, report or dashboard. Users can’t run Financial Reports or Oracle Business Intelligence Publisher reports from this interface. This interface can be used by all financials users.
- **BI Catalog**: A component of the Enterprise Performance Management Workspace where you can run all report types, except for Oracle Business Intelligence Publisher reports.
- **Enterprise Performance Management Workspace**: Create reports, books, snapshot reports, snapshot books, Financial Reporting batches, and batch scheduler, and schedule batches to automatically run and burst to email.
- **Enterprise Scheduler System**: Only Oracle Business Intelligence Publisher reports can be submitted from this interface. Users access this interface by navigating to **Tools > Scheduled Processes**. Most financial users have access to this interface to run standard reports for General Ledger, Payables, Receivables, and so on.

*Related Topics*
- Set Up Financial Reporting Center and Smart View

### Overview of Reports and Analytics Tools

The following are additional Oracle Fusion Financial reporting and analysis products:

- Oracle Business Intelligence Publisher (BI Publisher)
- Oracle Transactional Business Intelligence
- Oracle Business Intelligence Analytics
- Spreadsheet Integration
Oracle Business Intelligence Publisher

Oracle Business Intelligence Publisher provides the ability to create and format high-quality reports across Oracle Fusion Applications in general, including Oracle Fusion General Ledger. It applies templates, designed by your users in familiar desktop tools, to standard extracts and reports.

- Report layouts using familiar desktop tools, such as Adobe Acrobat PDF, Word, and Excel
- Ability to create one template to provide reports in many languages
- Reports published in various outputs such as Word, Excel, PDF, RTF, and HTML
- Scheduled reports for delivery to a wide range of destinations

Oracle Transactional Business Intelligence

Oracle Transactional Business Intelligence (Transaction BI) is a reporting tool that provides embedded analytics. Transaction BI supports online inquiry for most transactions, reducing the requirement to build and maintain user-defined reports. Transaction BI also provides:

- Drag-and-drop functionality to build the report layout, and immediately run the report to obtain real time results
- Shared queries and reports using the Report Catalog, a reporting option used to view or save specific definitions

Oracle Business Intelligence Analytics

Oracle Business Intelligence Analytics in Oracle Fusion:

- Supports real time, queries from an Oracle Fusion balances cubes and external data warehouses
- Contains prebuilt key performance indicators (KPIs) and metrics that deliver information throughout all levels of the organization
- Preaggregates data to summarize information across multiple data sources for faster queries

Spreadsheet Integration

You can transfer data easily and promptly to spreadsheets throughout Oracle Fusion General Ledger and Oracle Fusion Financials. In addition use the spreadsheet features in Financial Reporting, Smart View, and Business Intelligence. Watch for the XLS icon on the toolbar associated with a tabulation of data. Selection of the icon creates a spreadsheet tab with the displayed information.

Oracle Fusion Financials facilitates importing data by using prepared spreadsheet templates that include validation and control features.

⚠️ Caution: When working with these spreadsheets, changes are not recorded in Oracle Fusion Applications until the spreadsheet is uploaded. The upload appropriately fails unless users follow the conventions, statuses, search requirements, refresh requirements, and other instructions associated with the spreadsheet.
Related Topics

- Guidelines for Using Desktop Integrated Excel Workbooks

Financials Reports and Analytics Pane

The Reports and Analytics pane, also called BI Composer, is a central place to quickly view or run analytics and reports used in your work.

If you have the permission, you can:

- Create or edit reports and other analytic content by selecting subject areas, columns, filters, and prompts.
- Add reports from the business intelligence (BI) catalog to the pane.
- Find this pane in a panel tab. Navigate to: Tools > Reports and Analytics to open the Reports and Analytics work area. The pane appears as the Contents pane.

What's In the Pane?

This table describes what's in the Reports and Analytics pane's top-level folders.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Folders</td>
<td>Any user-defined analytics or reports that you saved for your own use only.</td>
</tr>
</tbody>
</table>
| Shared Folders  | - Any predefined analytics and reports that are relevant to your work area. Or, in the Reports and Analytics work area, all the analytics and reports that you have access to.  
|                 | - Any shared user-defined reports and analytics in the user-defined subfolder. Place your shared reports and analytics in this folder to protect them during upgrades. |

Business Intelligence Catalog

The business intelligence catalog stores all analytics, reports, and other BI objects. Each analysis, dashboard, or report in the Reports and Analytics pane represents a mapping, or link, to the same object in the catalog. The Reports and Analytics pane also reflects the folder structure of the BI catalog.

Where to Save Analytics and Reports

You save analyses, dashboards, and reports in the business intelligence (BI) catalog, along with other objects, including prompts and filters. The catalog has a hierarchy of folders, starting with My Folders and Shared Folders. One important folder is Custom, which you find in Shared Folders and use to store your modified analytics and reports.

My Folders

You're the only one who can access anything that you save in My Folders. You can see your saved items in My Folders on the Reports and Analytics work area, but not in My Folders in the Reports and Analytics panel tab on any other work area.
Introduction to Financial Reporting

The only exception is when you create an analysis using the wizard in the Reports and Analytics work area, and save it in My Folders. In this case, the analysis is available in any panel tab on all work areas.

Shared Folders

If you have the appropriate roles, you can also save in Shared Folders so that your modified analytics or reports are available to anyone with the correct access. You should save objects in the Custom subfolder, which has subfolders organized by product family.

Regarding predefined analytics and reports in Shared Folders:

- You should save a copy of the predefined analysis or dashboard in the corresponding product family subfolder in the Custom folder, and edit only the copy. Directly edit predefined analytics only when necessary, to make sure that any references to the analysis or dashboard still work properly.
- For predefined reports only, you can use a special Customize option to copy the report and also the folder structure and permissions. The copy is linked to the original, so editing the copy is like directly editing the original.

Custom Folder

Keep all modified analytics and reports in the Custom folder so that:

- You ensure that modified copies of those objects are not affected during upgrades, which can change predefined analytics and reports outside the Custom folder. You might lose changes saved outside the Custom folder during upgrades.
- You can easily find modified objects.
- You can edit objects in the Custom folder without compromising security on the original objects.

When you copy an object into the Custom folder, the copied object inherits the permission settings of the Custom folder. An administrator can reset the permissions on the object and the folder that it’s in.

Related Topics

- Reports and Analytics Work Area and Panel Tab
- What happens to modified analytics and reports when an update is applied
- How You Create and Edit Reports
- Overview of Analytics Creation and Modification
- How You Modify Copies of Predefined Reports

Business Intelligence Catalog

There are two major work areas for analytics administration. The main Engagement interface is where your users view the analytics administrators set up in user work areas and on the infolet pages. The second area is the business intelligence catalog. Reports, analyses, dashboards, and other business intelligence (BI) objects are stored and administered in the business intelligence catalog. BI is where you build and edit analytics for your user work areas. You can toggle back and forth between the two areas.
Navigate to the Catalog

1. Click **Tools > Reports and Analytics** in the Navigator.
2. In the Reports and Analytics work area, click the **Browse Catalog** button.

Objects in the Catalog

The catalog stores the BI objects in a folder structure of individual files, organized by product family.

BI objects and reports are organized in the following folder hierarchy:

- Shared Folders (parent)
- Product family (example: Financials)
- Product (example: Payables)
- Report groups (example: Invoices)
- Dashboard reports
- Data Models
- Report Components
- BI Publisher reports
- Prompts

The following table describes the common BI objects that you find in the catalog:

<table>
<thead>
<tr>
<th>Catalog Object</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>Analyses are used for infolets, the Sales pages, and on object pages such as Opportunities.</td>
<td>Analytics library</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Dashboards organize analytical content and catalog objects, and present them in a meaningful way.</td>
<td>Reporting group folder</td>
</tr>
<tr>
<td>Dashboard Prompt</td>
<td>Dashboard prompts allow users to filter dashboard content using provided values.</td>
<td>Prompts folder</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters are used in dashboards and analyses.</td>
<td>Prompts folder</td>
</tr>
<tr>
<td>Report</td>
<td>Reports are operational reports in printable format created in Business Intelligence Publisher.</td>
<td>Analytics library</td>
</tr>
<tr>
<td>Data Model</td>
<td>Data models are used by reports created in Business Intelligence Publisher.</td>
<td>Data Models folder</td>
</tr>
<tr>
<td>Catalog Object</td>
<td>Description</td>
<td>Location</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Sub-template</td>
<td>Sub-templates are used by reports created in Business Intelligence Publisher.</td>
<td>Reporting group folder</td>
</tr>
</tbody>
</table>
Oracle Transactional Business Intelligence for Financials

Video

Watch: This video is the first in a series of tutorials on Oracle Transactional Business Intelligence for Financials. Oracle Transactional Business Intelligence is an ad hoc reporting tool that you can use to create your own analyses using information from your Financials applications. The content of this video is also covered in text topics.

Procedure

In this example, you view an analysis called the Payables Aging Summary. This analysis was created using Oracle Transactional Business Intelligence, an ad hoc reporting tool. You can use the tool to create analyses, dashboards, and infolets using information from your Oracle Financials Cloud applications.

Viewing an Analysis

1. Let’s start from the Financial Reporting Center and search for the Payables Aging Summary.
2. Click the Expand icon to see details like type and location.
   In this example, the type is Analysis. The location shows you where the analysis is stored.
3. Click the title.
   Now you can see the analysis. The information here is real time and based on the latest transaction information. This analysis has bars and a table that show totals by aging categories like Current, Overdue 21 - 60 days, and so on. You can use different views like time series lines, bars, tables, and heat maps in your analyses. An analysis can use more than one type of view to help arrange information in a way that’s useful for your audience.
4. Click the Overdue 91-180 Days bar.
   A table shows the invoices that make up the total for this category. You can see invoice details like supplier name, invoice due date, invoice number, and unpaid amount.
5. Click the Buckets drop-down list to change categories.
   Now you see the details that make up another aging total.
6. Go back to the previous page.
7. Click the Analysis icon after the title.
8. Click the Edit link to open the layout.
   You can make changes here and save them in the same location, or you can save them in another area that you have access to. You can also create another analysis. Just click the New menu to get started.

Explore Financial Subject Areas in Oracle Transactional Business Intelligence
**Oracle Financials Cloud**
**Creating Analytics and Reports for Financials**

---

### Video

**Watch:** This video shows you how to find the Financials subject areas in Oracle Transactional Business Intelligence and describes the types of information they contain. This video is one in a series of tutorials on using Oracle Transactional Business Intelligence for your Financials applications. The content of this video is also covered in text topics.

---

### Procedure

In this example, you examine Financial subject areas in Oracle Transactional Business Intelligence. Here’s the list of Financial products with subject areas: Assets, Budgetary Control, Cash Management, Expenses, General Ledger, Intercompany, Payables, Receivables, Revenue Management, and Subledger Accounting.

2. Click **Tasks**.
3. Click **Open Workspace for Financial Reports**.
4. Select **Navigate > Applications > BI Catalog**.
5. You have to create an analysis to see the subject areas you have access to:
   - Click the **New** icon.
   - Click **Analysis**.

Subject areas are organized in folders and the information they contain varies based upon reporting requirements. General Ledger subject areas cover account balances, journals, and period statuses.

6. Select the **General Ledger Transactional Balances - Real Time** subject area. The term **Real Time** in the subject area name indicates the information is up-to-date as of the latest general ledger journal posting. You can use this subject area to create trial balances and general queries to review changes in account balances over time. Here are some of the folders that appear in the Subject Area pane:
   - Balancing Segment
   - Cost Center Segment
   - Currency
   - Time
   - Ledger
   - Ledger Set

You can expand folders to see their components. For example, the Time folder contains accounting period and year. If you have more than one ledger, you can create an analysis that filters by ledger and ledger set. You can query a specific general ledger balance, or groups of general ledger balances.

7. Click the **Add or Remove Subject Areas** icon in the Subject Areas toolbar to view more subject areas and the type of information they hold.

For example, with the Payables subject areas you can examine information about suppliers, supplier balances, and invoices, including freight and tax charges. You can also see how invoices and payments affect the general ledger. An analysis can show which invoices were paid on time and whether checks have cleared.
The Receivables subject areas include customer information, customer balances, and invoice details such as terms and receipts, credit memos, and revenue adjustments. Similar to Payables, you could analyze how receipts affect general ledger account balances.

**Overview of Analytics Creation and Modification**

Edit and create analytics to provide ad hoc reporting on your transactional data. The predefined analyses and dashboards help answer many of your business questions, but you can also create your own to meet your requirements.

This table gives a just a few examples of creating or editing analytics.

<table>
<thead>
<tr>
<th>Task</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an analysis</td>
<td>Your team needs a simple list of all your accounts, sorted by account ID. You include the account name, ID, and address in a new analysis, and add sorting on the ID column.</td>
</tr>
<tr>
<td>Create a view</td>
<td>A predefined analysis has a bar graph. You save a new version of this analysis with a table view added to the graph.</td>
</tr>
<tr>
<td>Create a view selector</td>
<td>You later decide that you want to toggle between viewing a table and a graph. You add a view selector that includes the table and graph views.</td>
</tr>
<tr>
<td>Edit a dashboard prompt</td>
<td>A predefined dashboard has a Start Date prompt. You make a copy of the dashboard and replace Start Date with a date range prompt.</td>
</tr>
<tr>
<td>Create a dashboard</td>
<td>You create a dashboard that includes an analysis and a report to view both together.</td>
</tr>
</tbody>
</table>

**Tip:** A wizard in the Reports and Analytics work area and panel tab is available to help you create or edit analyses.

**Data Source Modification**

Administrators can modify the business intelligence (BI) repository to determine the columns available for you to use.

- They enable flexfields (which support attributes) for BI, and import them into the repository.
- You can then select attributes from flexfields to include in your analyses.

**Related Topics**

- Reports and Analytics Work Area and Panel Tab
- How Data Is Structured for Analytics
- Overview of Flexfield Use in Analyses
Create and Edit Analyses Using a Wizard

You can use a wizard that guides you through creating and editing analyses. Even though the wizard doesn't give you all available features, you can still use it to make typical changes, for example adding views or filters. For other tasks, such as creating dashboards or deleting analyses, use the advanced business intelligence features.

Creating an Analysis

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click Create and select Analysis.
3. Select the subject area that has the columns you want for your analysis.
4. Optionally, add more subject areas or remove any that you no longer need.
5. Select the columns to include, set options for each column, and click Next.
6. Optionally, enter a title to display for the analysis.
7. Select the type of table or graph to include, specify the layout of the views, and click Next.

Note: At any point after this step, you can click Finish to go to the last step, to save your analysis.

8. Optionally, set more options for the table or graph, and click Next.
9. Optionally, add sorts or filters based on any of the columns you included, and click Next.
10. If you have a table, optionally define conditional formatting for select columns, for example to display amounts over a certain threshold in red. Click Next.
11. Enter the name of your analysis and select a folder to save it in.
12. Click Submit.

Editing an Analysis

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the analysis.
2. Select your analysis and edit it. In the Reports and Analytics work area, click More for the analysis and select Edit.
   In the Reports and Analytics panel tab, click the analysis, then click Edit.
3. Perform steps 4 through 10 from the preceding Creating an Analysis task, as needed.
4. To update an existing analysis, select the same name in the same folder. To save this analysis as a new copy, either name it with a new name or save it in a new folder.
5. Click Submit.

Related Topics

- Reports and Analytics Work Area and Panel Tab
- Where to Save Analytics and Reports
- How Data Is Structured for Analytics
Create and Edit a Financial Analysis Using a Wizard

You can use a wizard that guides you through creating and editing analyses. Even though the wizard doesn't give you all available features, you can still use it to make typical changes, for example, adding views and filters.

Note: The wizard isn’t available for dashboards and you can’t use it to delete analyses.

Creating an Analysis

1. Navigator > Tools: Reports and Analytics.
2. Click Create and select Analysis.
3. Select a subject area that you want to analyze, for example, the General Ledger - Journals Real Time subject area.
4. Select the columns to include:
   - Journal Batches: Batch Details: Journal Batch
   - Journal Headers: Header Details: Journal Header Description
   - Journal Lines: Line Details: Line
   - Journal Lines:
     - Accounted Debit
     - Accounted Credit
   - Time: Accounting Period Name
5. Set the following options:
   - Interaction: Default
   - Hidden: Leave unchecked
6. Click Next
8. Select the type of table and click Next.

Tip: At any point after this step, you can click Submit to go to the last step, to save your analysis.

9. Enter the name of your analysis By Cost Center and select the My Folder.
10. Click Submit.

Editing an Analysis

1. Navigator > Tools: Reports and Analytics.
2. Select your analysis By Cost Center in the pane and click Edit.
3. Add Posting Status: Posting Status Meaning.
4. Click Submit: Save your analysis with the same name in the same folder.
Tip: You can create a copy of the analysis, whether you edited it or not, just by saving it either with a new name or in a new folder.

Manage Analytics with Advanced Features

Even though you can use a wizard to create or edit analyses, you might have to use advanced features for complicated analyses or specific requirements. For example, you can create view selectors so that users can toggle between views within an analysis, or define criteria for filters using SQL statements.

You can also perform other actions on analyses, for example delete them or copy and paste them within the business intelligence catalog.

How to Create and Edit Analytics

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click the Browse Catalog button.
3. Click the New button, select Analysis in Analysis and Interactive Reporting, and select a subject area.
   Or, select your analysis in the Folders pane and click Edit.
4. Use the tabs as described in this table.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Criteria</td>
<td>Select and define the columns to include.</td>
</tr>
<tr>
<td></td>
<td>Add filters.</td>
</tr>
<tr>
<td>Results</td>
<td>Add views and set options for results.</td>
</tr>
<tr>
<td>Prompts</td>
<td>Define prompts to filter all views in the analysis.</td>
</tr>
<tr>
<td>Advanced</td>
<td>View or update the XML code and logical SQL statement that the analysis generates.</td>
</tr>
<tr>
<td></td>
<td>Set options related to query performance.</td>
</tr>
</tbody>
</table>

5. Save your analysis.

More Actions on Analytics

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the analysis.
2. Select your analysis and click Action and select More.
3. Click More for your analysis and select the wanted action, for example Delete or Copy.
Add an Analysis to the Project Performance Dashboard

This example shows how to add an analysis to the Project Performance Dashboard. This dashboard is a page in the application, not a dashboard in the business intelligence (BI) catalog.

You can add predefined or user-defined analyses to any desktop page that you can personalize or edit.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which analysis do you want to add to the dashboard?</td>
<td>Project Income Statement</td>
</tr>
</tbody>
</table>

⚠️ **Caution:** Ensure that the analysis doesn’t query a large number of records. If it is, then the Project Performance Dashboard page can take a long time to open after you add the analysis.

| Do you have to change the layout of the page? | Yes, to a two-column layout that is wider on the right side. |

🔍 **Note:** The one- or two-column layout gives enough space to properly display analyses.

| Do you want all or only one view of the analysis? | All views. |

| Are these changes for you only, or for all users of the Project Performance Dashboard? | You only. |

Adding an Analysis

1. Open the Project Performance Dashboard.
2. Click your name in the global header and from the Administration submenu select **Edit Pages...**
3. You need to be in an active sandbox session to add an analysis. Activate a sandbox if you’re not already in a sandbox session. Click **Activate Sandbox.**
   If you are already in an active sandbox session, steps 3 to 7 are not required.
4. On the Manage Sandboxes window, select a sandbox and click **Set as Active.**
5. After you activate the sandbox, the application redirects you to the home page. On the Warning window, click Yes to continue.
6. Open the Project Performance Dashboard.
7. Click your name in the global header and from the Administration submenu select Edit Pages....
8. Click Change Layout and select the Two columns, narrow left option.
9. Click Add Content for the wider column.
   The Reports and Analytics folder in the Add Content dialog box contains what’s in the BI catalog.
10. Click through the folders in the catalog until you see the Project Financials Sample Reports folder. Click the name of the analysis in this folder, and click Add to include all views of the analysis.
   If you click Open or Project Income Statement, you can select a specific view to add.
11. Click Close after you see the analysis added to the top of the wider column on the dashboard.
12. Click Close to close the composer view and view the dashboard.

Create and Edit Dashboards

You can create and edit dashboards to determine their content and layout. In addition to objects in the business intelligence (BI) catalog, such as analyses, reports, and prompts, you can add text, sections, and more to a dashboard.

Creating a Dashboard

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click Browse Catalog.
3. Click New and select Dashboard under Analysis and Interactive Reporting.
4. Enter the dashboard’s name and description, and select a folder to save in.
5. With the Add content now option selected, click OK.
6. Optionally, add more pages, or tabs, within the dashboard.
7. Drag and drop items from the Dashboard Objects or Catalog pane to add content to a page.
8. Click Save.

Note: The first dashboard page is saved with the page 1 name by default. To rename this page:
   1. Click the Catalog link.
   2. In the Folders pane, select your dashboard.
   3. For page 1, click More and select Rename.
   4. Enter the new name and click OK.

Editing a Dashboard

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the dashboard.
2. Select your dashboard in the pane and click More.
3. Click Edit.
4. Perform steps 5 and 6 from the preceding Creating Dashboards task, and make other changes as needed, for example:
   - Remove content from the dashboard.
Drag and drop within a page to move content around.
- Change the layout of a page.

**Related Topics**
- Where to Save Analytics and Reports
- Reports and Analytics Work Area and Panel Tab

## Copy the Payables Invoice Audit Listing Dashboard

This example shows how to copy a predefined dashboard so that you can edit the copy and not the original. If you have appropriate roles, then you can (only if necessary) create dashboards or edit predefined ones directly. If not, then you must copy predefined dashboards and edit the copies.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which predefined dashboard are you copying?</td>
<td>Payables Invoice Audit Listing</td>
</tr>
<tr>
<td>Is the copied version for yourself only or for multiple users?</td>
<td>Multiple users</td>
</tr>
</tbody>
</table>

To copy the dashboard and get it working:
- Make a copy of the Payables Invoice Audit Listing dashboard.
- Copy the components of the dashboard, the analysis and prompt.
- Edit the copied dashboard so that it contains the copied analysis and prompt instead of the predefined ones.

Save your copies under **Shared Folders > Custom** in the business intelligence (BI) catalog. You must create folders within Custom so that the copies have a folder path similar to the originals.

### Copying the Dashboard

1. Open the Reports and Analytics work area.
2. In the Contents pane, select **Shared Folders > Financials > Payables > Invoices > Payables Invoice Audit Listing > Invoice Audit Listing**, and click the More link.
3. With the Payables Invoice Audit Listing dashboard selected in the Folders pane, click the Copy button on the toolbar.
4. In the Folders pane, select **Shared Folders > Custom > Financials**.
5. On the toolbar, click the New button and select Folder.
6. Enter **Payables** in the Name field and click OK.
7. Create an Invoices subfolder within the new Payables folder.
8. Click Paste on the toolbar to copy the dashboard into the Invoices folder.
Copying the Prompt and Analysis

1. With the Invoices folder still open, click **New** on the toolbar and select **Folder**.
2. Enter **Prompts** in the **Name** field and click **OK**.
3. Create another folder with the name **Report Components**. (In this context, report refers to the dashboard.)
4. In the Folders pane, select **Shared Folders > Financials > Payables > Invoices > Prompts**.
5. For the Payables Invoice Audit Listing dashboard prompt, click the **More** link and select **Copy**.
6. In the Folders pane, select **Shared Folders > Custom > Financials > Payables > Invoices > Prompts**, and click **Paste** on the toolbar.
7. In the Folders pane, select **Shared Folders > Financials > Payables > Invoices > Report Components**.
8. For the Payables Invoice Audit Listing analysis, click the **More** link and select **Copy**.
9. In the Folders pane, select **Shared Folders > Custom > Financials > Payables > Invoices > Report Components**, and click **Paste** on the toolbar.

Editing the Copied Dashboard

1. In the Folders pane, select **Shared Folders > Custom > Financials > Payables > Invoices > Payables Invoice Audit Listing**.
2. Click the **Edit** link for the Invoice Audit Listing dashboard.
3. Click the **Delete** button for the Payables Invoice Audit Listing dashboard prompt within the Search region.
4. In the Catalog pane, select **Shared Folders > Custom > Financials > Payables > Invoices > Prompts > Payables Invoice Audit Listing** and move it into the Search region.
5. Delete the Payables Invoice Audit Listing compound view within the Section 1 region.
6. In the Catalog pane, select **Shared Folders > Custom > Financials > Payables > Invoices > Report Components > Payables Invoice Audit Listing** and move it into the Section 1 region.
7. Click **Save**.

Repository and Session Variables for Business Intelligence

This table shows repository and session variables available for use in your analyses.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Type</th>
<th>Usage</th>
<th>Offering</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER_MAX_TERR_HIER_LEVEL</td>
<td>Session Variable</td>
<td>Returns the maximum fixed hierarchy level from Territory Hierarchy for the logged-in user. This variable can be used to dynamically retrieve the maximum territory level that the logged-in user owns.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>USER_ORG_HIER_LEVEL</td>
<td>Session Variable</td>
<td>Holds the hierarchy level within the organization selected by the user in a report.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>USER_PARTY_ID</td>
<td>Session Variable</td>
<td>Stores the PARTY_ID from UserPVO.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Type</td>
<td>Usage</td>
<td>Offering</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------</td>
<td>----------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>CURRENT_DAY</td>
<td>Session Variable</td>
<td>Returns the value of Current Date.</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_MONTH</td>
<td>Repository Variable</td>
<td>Returns the value of Current Month in the YYYY/MM format</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_WEEK</td>
<td>Repository Variable</td>
<td>Returns the value of the current week in YYYY Weeknnn format.</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Current Quarter in YYYY Q nn format.</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Current Year in the YYYY format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_MONTH</td>
<td>Repository Variable</td>
<td>Returns the value of Next Month in the YYYY/MM format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_WEEK</td>
<td>Repository Variable</td>
<td>Returns the value of Next Week in the YYYY Week nn format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Next Calendar Quarter in YYYY Q nn format.</td>
<td>All</td>
</tr>
<tr>
<td>NEXT_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Next Year in the YYYY format.</td>
<td>All</td>
</tr>
<tr>
<td>PREVIOUS_MONTH</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Month in the YYYY/MM format</td>
<td>All</td>
</tr>
<tr>
<td>PREVIOUS_WEEK</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Week in the YYYY Week nn format.</td>
<td>All</td>
</tr>
<tr>
<td>PREVIOUS_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Quarter in the YYYY Q nn format.</td>
<td>All</td>
</tr>
<tr>
<td>PREVIOUS_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Year in the YYYY format.</td>
<td>All</td>
</tr>
<tr>
<td>CURRENT_ENTERPRISE_PERIOD</td>
<td>Repository Variable</td>
<td>Returns the value of the Current Fiscal Period.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>CURRENT_ENTERPRISE_PERIOD_END_DATE</td>
<td>Session Variable</td>
<td>Returns the End date of Current Enterprise Period.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>Variable Name</td>
<td>Type</td>
<td>Usage</td>
<td>Offering</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>CURRENT_ENTERPRISE_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Current Enterprise Quarter in the YYYY Qn format.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>CURRENT_ENTERPRISE_QUARTER_END_DATE</td>
<td>Session Variable</td>
<td>Returns the End date of Current Enterprise Quarter.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>CURRENT_ENTERPRISE_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Current Enterprise Week in the YYYY Weeknn format.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>NEXT_ENTERPRISE_PERIOD</td>
<td>Repository Variable</td>
<td>Returns the value of Next Enterprise Period.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>NEXT_ENTERPRISE_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Next Enterprise Quarter in the YYYY Qn.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>NEXT_ENTERPRISE_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Next Enterprise Year in the FYYYYY format.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>PREVIOUS_ENTERPRISE_PERIOD</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Enterprise Period.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>PREVIOUS_ENTERPRISE_QUARTER</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Enterprise Quarter in the YYYY Qn format.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>PREVIOUS_ENTERPRISE_YEAR</td>
<td>Repository Variable</td>
<td>Returns the value of Previous Enterprise Year in the FYYYYY format.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>SVC_SR_ASSIGN_INIT_DT</td>
<td>Session Variable</td>
<td>Returns a date when the POD was upgraded to latest version.</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>PERSON_ID_HCM</td>
<td>Session Variable</td>
<td>Identifies the person ID of the logged in user.</td>
<td>Human Capital Management</td>
</tr>
<tr>
<td>CURRENT_MONTH_END_DATE_REP_OTBI</td>
<td>Repository Variable</td>
<td>Returns the current Gregorian month end date.</td>
<td>Supply Chain Management</td>
</tr>
<tr>
<td>CURRENT_MONTH_START_DATE_REP_OTBI</td>
<td>Repository Variable</td>
<td>Returns the current Gregorian month start date.</td>
<td>Supply Chain Management</td>
</tr>
<tr>
<td>CURRENT_WEEK_END_DATE_REP_OTBI</td>
<td>Repository Variable</td>
<td>Returns the current Gregorian week end date.</td>
<td>Supply Chain Management</td>
</tr>
<tr>
<td>CURRENT_WEEK_START_DATE_REP_OTBI</td>
<td>Repository Variable</td>
<td>Returns current Gregorian week start date.</td>
<td>Supply Chain Management</td>
</tr>
</tbody>
</table>
## FAQs

What happens to modified analytics and reports when an update is applied?

When saved in the Custom subfolder within Shared Folders, or in My Folders in the business intelligence (BI) catalog, modified analytics and reports are preserved during an update. Any modified objects in the Custom folder are preserved in any update. Changes to existing analytics and reports outside the Custom folder, including those you create, are preserved only if the update doesn’t include a new version of those BI objects. If the update includes a new version of a predefined object that you edited outside the Custom folder, then:

- The new version overwrites the existing predefined object.
- A copy of the existing object (with your edits) is automatically created in the same folder, with a new name that indicates it’s a new version.

If the update includes a new version of both the predefined object and a folder in its file path, then:

- The new folder, along with the new version of the object, overwrites the existing predefined folder and object.
- A copy of the existing folder (along with your edited object) is automatically created. The folder is renamed to indicate that it’s a new version, but your edited object is not renamed.

**Note:** Future updates won’t affect renamed objects or anything within a renamed folder.
3 Subject Areas for Analytics

How Data Is Structured for Analytics

The business intelligence (BI) repository contains the metadata that defines which columns you can include in analyses, and the source of that data. The repository is organized into subject areas, which contain folders with the columns.

Note: You can also use the BI repository as a data source for reports.

Columns

This table describes the three types of columns available when you create or edit analyses.

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fact</td>
<td>Provides a measure of something, meaning that the values are numbers.</td>
<td>Total</td>
</tr>
<tr>
<td>Attribute</td>
<td>Represents a piece of information about a business object, with values that are dates, IDs, or text.</td>
<td>Start Date</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Holds data values that are organized in a hierarchical manner.</td>
<td>Time, with sublevels:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Year</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Quarter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Month</td>
</tr>
</tbody>
</table>

Note: Attribute columns can be flexfield segments imported into the BI repository.

Subject Areas

When you create an analysis, you first select a subject area, which contains columns related to a specific business object or area. Then, open folders within the subject area to find the columns to include.

Folders

Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders.

- Fact folders:
  - Contain fact columns.
  - Are usually the last in a list of folders and are usually named after the subject area.
• **Dimension folders:**
  - Contain attribute and hierarchical columns.
  - Are joined to the fact folder within a subject area.
    For example, if your analysis has the Currency attribute from a dimension folder, you see currencies in the results. If you also add the Total fact, then your analysis includes only records with both a currency and a total amount. The more columns you add, the smaller the query set for your analysis.
  - Can be common folders, or common dimensions, that appear in more than one subject area.
    If your analysis has columns from multiple subject areas, then you:
    - Should include columns only from dimension folders that are common to all of those subject areas. At least one such column is required.
    - Must include one column from the fact folder in each of those subject areas.

**Related Topics**
- Overview of Analytics Creation and Modification
- Manage Analytics with Advanced Features
- Create and Edit Analyses Using a Wizard
- Modify Data Models

**Financials Data Structure for Analytics**

The BI repository contains metadata that defines which columns (or slices of data) are available to be included in analyses. The repository also shows where the data for each column comes from. The repository is organized into subject areas which contain folders with columns. You can also use the BI repository as a data source for reports.

**Columns**

The following table describes the three types of columns.

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Description</th>
<th>Example</th>
<th>Icon for Column Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fact</td>
<td>Provides a measure of values that are numbers.</td>
<td>Credit Amount on Journal Line</td>
<td>Ruler</td>
</tr>
<tr>
<td>Attribute</td>
<td>Represents information about a business object with values that are dates, IDs, or text. Attribute columns can be flexfield segments imported into the BI repository.</td>
<td>Approval Status Code on a journal entry.</td>
<td>Piece of paper</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Holds data values that are organized in a hierarchical manner.</td>
<td>Accounting Period - Year</td>
<td>Column: Hierarchy of squares</td>
</tr>
</tbody>
</table>
Subject Areas

When you create an analysis, you:

- First select a subject area which contains columns related to a specific business object or business area. For example, General Ledger - Balances Real Time.
- Then open folders within the subject area to find the columns to include in your analysis. For example, you can open the Approval Status folder and select the columns within it.

Folders

Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders. For example, the Journal Lines folder in General Ledger - Journals Real Time subject area has multiple subfolders like Account, Line Details, and Lines.

The definitions of Fact and Dimension folders are:

- Fact: A measure or metric. A fact consists of numbers. A report more often than not contains at least one fact and not more than a few facts.
- Dimension: Provides the context for the fact. A dimension is descriptive.

Note: Facts and dimensions make up the report columns.

- Fact folders:
  - Contain fact columns.
  - Are usually last in the list of folders and are usually named after the subject area.
- Dimension folders:
  - Contain attribute and hierarchical columns.
  - Are joined to the fact folder within a subject area.

  For example, if your analysis has Currency attribute from a dimension folder, you see currencies in the results. If you also add the Total fact, then your analysis includes only records with both a currency and a total amount. The more columns you add, the smaller the query set for your analysis becomes.
  - Can be common folders or common dimensions that appear in more than one subject area. If your analysis has columns from multiple subject areas then you:
    - Must include columns only from dimension folders that are common to all those subject areas. At least one such column is required.
    - Must include one column from the fact folder in each of those subject areas.
Note: For more information, see Financials Cloud OTBI Release 11: Subject Area Document on Customer Connect at: https://appsconnect.oracle.com/files/8164acf4e9/FINS_OTBI_Subject_Area_Documentation_R_11_FINAL.pdf

Related Topics

- Oracle Financials Cloud Subject Areas for Transactional Business Intelligence in Financials
Overview of Oracle BI Publisher Best Practices for SaaS Environments

Oracle Business Intelligence Publisher is an enterprise reporting solution for creating highly formatted, pixel perfect reports. It offers a single solution environment to author, manage, and deliver a variety of business documents. Oracle BI Publisher is available to customers with Oracle BI Suite Plus and Oracle BI Foundation. The product is also available standalone as Oracle BI Publisher Enterprise. Often these reports process large amounts of data, which requires product teams and end customers to understand the best practices of Oracle BI Publisher.

Often the reports process large amounts of data, which requires product teams and end customers to understand the best practices of Oracle BI Publisher. This white paper provides a detailed list of best practices that are recommended by Oracle when using Oracle BI Publisher in a Software-as-a-Service (SaaS) environment. For more information, see Oracle BI Publisher Best Practices for SaaS Environments document ID 2145444.1 on My Oracle Support at https://support.oracle.com.

Configure Reports

How You Create and Edit Reports

Use reports to generate and print documents for internal operations, external business transactions, or legal requirements. To meet specific requirements, you must create or edit reports to capture different data, or present data in another way.

Report Components

Each report has components that you can modify, as described in this table:

<table>
<thead>
<tr>
<th>Report Component</th>
<th>Description</th>
<th>Tool for Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data model</td>
<td>Defines the data source, data structure, and parameters for the report. Multiple reports can use the same data model. Each report has one data model.</td>
<td>Data model editor in the application</td>
</tr>
</tbody>
</table>
| Layout           | Defines the presentation, formatting, and visualizations of the data. A report can have multiple layouts. Different types of layout templates are available, for example Excel and RTF. | Depending on the template file type:  
  - **XPT**: Layout editor in the application  
  - **RTF**: Microsoft Word  
  - **PDF**: Adobe Acrobat Professional  
  - **Excel**: Microsoft Excel  
  - **eText**: Microsoft Word |
| Properties       | Specifies formatting and other settings for the report. | Report editor in the application |
What You Can Create or Edit

This table gives just a few examples of creating or editing reports.

<table>
<thead>
<tr>
<th>Task</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the layout of a report.</td>
<td>Add your company logo to the report output.</td>
</tr>
<tr>
<td>Add a new layout to a report.</td>
<td>Design a new layout template that provides less detail than the existing template.</td>
</tr>
<tr>
<td>Edit a data model.</td>
<td>Add two fields to the data model used by a report so you can add those new fields to a layout for the report.</td>
</tr>
<tr>
<td>Create a new report based on a new data model.</td>
<td>Create a new data model based on data from an external system, and create reports using the data model.</td>
</tr>
</tbody>
</table>

How You Access and Modify Report Components

To create or edit reports, you must access the business intelligence (BI) catalog. In the catalog, objects of type Report represent the report definition, which includes report properties and layouts. Data models are separate objects in the catalog, usually stored in subfolders called Data Models.

Accessing the BI Catalog

You can access the BI catalog in any of the following ways:

- In the Reports and Analytics work area, click **Browse Catalog** to open the BI catalog, and find your report or data model in the Folders pane.
- In the Reports and Analytics work area, find your report and select **More** to go to the report directly in the catalog. The data model associated with the report should be in the Data Models subfolder within the same folder as the report.
- Sign in to the application directly (for example: http://host:port/analytics/saw.dll) to open the catalog.
- Sign in to the BI Publisher server directly (for example: http://hostname.com:7001/xmlpserver) to open the catalog.
  - Alternatively, once you are in the catalog using another method, for example, through the Reports and Analytics work area, change the final node of the URL. For example, change (http://host:port/analytics/saw.dll) to xmlpserver. So the URL you use would be: http://host:port/xmlpserver.

Predefined Reports

A special Customize option is available only:

- For predefined reports, not data models.
- Through direct access to the BI Publisher server using the /xmlpserver URL. When you find your report in the BI catalog, select **Customize** from the More menu.

The Customize option automatically creates a copy of a predefined report and stores it in the **Shared Folders > Custom** folder within the catalog. The new report is linked to the original, so that when users open or schedule the original, they are actually using the copied version.
If you don’t have access to the Customize option or don’t want the original version linked to the new report, make a copy of the predefined report and save it in the Custom folder.

### Predefined Data Models

Don’t edit predefined data models. Instead, copy the data model into the Custom folder and edit the copy. You can’t create a new data model based on the transactional tables.

**Related Topics**

- Where to Save Analytics and Reports
- What happens to modified analytics and reports when an update is applied

### How You Modify Copies of Predefined Reports

The Customize option automatically creates a copy of a predefined report and stores it in the **Shared Folders > Custom** within the business intelligence (BI) catalog. The copy includes the report definition, folder structure, and original report permissions, and is linked internally to the original report. You can edit the copy of the report, leaving the original report intact. When users open or schedule the original report, they are actually using the newer version.

**Benefits of the Customize Option**

In addition to conveniently copying a predefined report to the Custom folder, the Customize option:

- Makes it unnecessary to update processes or applications that call the report. For example, if the original report is set up to run as a scheduled process, you don’t need to change the setup. When users submit the same scheduled process, the newer report runs instead of the original.
- Automatically copies the security settings of the original report.
- Removes the risk of patches overwriting your edits. If a patch updates the original report, the newer report is not updated in any way.

> **Note:** The report still references the original data model. The data model is not copied. A patch that updates the data structure of the data model might affect your report.

### Accessing the Customize Option

To access the Customize option:

2. In the Folders pane, select the predefined report.
3. Select **Customize** from the **More** menu for the report.
4. The copied report in the Custom folder opens, so proceed to edit this report.

To edit the copied report again later, you don’t need to be in the BI server. Just go to the BI catalog and either:

- Select the **Customize** or **Edit** option for the original report.
- Find your report in the Custom folder and select **Edit**.

**Related Topics**

- Where to Save Analytics and Reports
• What happens to modified analytics and reports when an update is applied

How Links Between Original and Modified Reports Are Managed

The Customize option for predefined reports creates a copy of the report that is linked to the original. Consider the following points when you work with both the original and modified versions.

Maintaining the Link Between Reports

The link between the predefined and modified report is based on the name of the modified report and its location within the Custom folder in the business intelligence (BI) catalog.

- If you manually create a report with the same name as a predefined report, and give it the same folder path in the Custom folder, then the new report becomes a version of the original. It would be as if you had used the Customize option to create a copy of the predefined report.
- You can edit the report so that it uses a different data model. But if the original data model is updated later, then your newer report doesn’t benefit from the change.

⚠️ Caution: The link to the original report breaks if you rename the modified or original report.

Tasks Performed on Original Reports

This table describes what happens when you use the original report and a corresponding copied report exists.

<table>
<thead>
<tr>
<th>Task Performed on the Original Report</th>
<th>Result When There Is a Copied Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the copied report.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Creates a report submission for the copied report.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the copied report.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the original report only. If you delete the copied report, the original report is not deleted.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the original report.</td>
</tr>
<tr>
<td>Cut and Paste</td>
<td>Cuts and pastes the original report.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames the original report. The copied report name is not changed.</td>
</tr>
</tbody>
</table>

⚠️ Caution: This breaks the link between the original and copied reports.

Download                               | Downloads the copied report.         |
Customize                              | Edits the copied report.             |
History                                | Opens the job history of the copied report. |
Create and Edit Report Layouts

The layout determines what and how data is displayed on report output. Each report has at least one layout template. This topic describes the following aspects of report templates:

- Layout templates
- Layout template types
- Overall process of managing layouts
- Deleting layout templates

Layout Templates

To modify a layout, you edit the layout template, which:

- Defines the presentation components, such as tables and labeled fields.
- Maps columns from the data model to these components so that the data is displayed in the correct place.
- Defines font sizes, styles, borders, shading, and other formatting, including images such as a company logo.

Layout Template Types

There are a few types of template files to support different report layout requirements.

- **RTF**: Rich text format (RTF) templates created using Microsoft Word.
- **XPT**: Created using the application’s layout editor, these templates are for interactive and more visually appealing layouts.
- **eText**: These templates are specifically for Electronic Data Interchange (EDI) and electronic funds transfer (EFT) information.

You can also create and edit other types of templates using Adobe PDF, Microsoft Excel, Adobe Flash, and XSL-FO.

Overall Process to Create or Edit Layouts

Editing or creating report layout, for example using Microsoft Word or the layout editor, involves making the actual changes to the template file. But that task is just one part of the entire process for modifying layouts.

1. Copy the original report and save the new version in **Shared Folders > Custom** in the business intelligence (BI) catalog. You create or edit templates for the new copy of the report.

   **Tip:** You can use the Customize option if the original is a predefined report.
2. Review report settings for online viewing.
3. Generate sample data for the report.
4. Edit or create the layout template file.
5. Upload the template file to the report definition. Skip this step if you’re using the layout editor.
6. Configure the layout settings.

Deleting Layout Templates
To remove a layout template for a report:
1. Select your report in the BI catalog and click Edit.
2. In the report editor, click View a list.
3. Select the layout template and click Delete.

Modify Data Models
A data model defines where data for a report comes from and how that data is retrieved. If a data model can’t give you all the data that you need in your report, then you can either copy and edit an existing data model or create a new one. You must be a BI Administrator to create new data models.

Creating a Data Model
1. In the business intelligence (BI) catalog, click the New button and select Data Model in Published Reporting.
2. Optionally click the Data Model node in the Data Model pane to set properties for the data model.
3. Click the Data Set node in the Data Model pane to create or edit data sets, which determine where and how to retrieve data.
4. Click the New Data Set button and select a data set type. It’s best practice to use the BI repository as a data source, so you should select either:
   - Oracle BI Analysis: To use columns from a selected analysis.
   - SQL Query: To use a Query Builder tool to define what to use from the repository. Select Oracle BI EE as the data source.
5. Optionally, to limit the data included in the report output, click the Parameters node in the Data Model pane to define variables that users can set when they use the report.

   **Note:** The order of parameters is important if there are job definitions defined for reports that use your data model. If you change the order in the data model, you must also update the job definitions.

6. Optionally, define other components of the data model.
7. Click Validate to validate your data model. Errors and warnings pertaining to query performance are displayed. In case of errors in validation, the model is usable in development, but will not be available in production until errors are resolved.
8. Save your data model.

Editing a Data Model
1. To edit a predefined data model:
   a. Find the data model in the BI catalog and click Copy.
b. Paste within **Shared Folders > Custom** in a subfolder that has a folder path similar to the folder that stores the original data model.

c. For the data model you pasted, click **More**, and select **Edit**.

2. Optionally click the **Data Model** node in the Data Model pane to set properties for the data model.

3. Click the **Data Set** node in the Data Model pane to create or edit data sets.

Most predefined data models are of type SQL Query, and are set up to get application data from the following tables:

- **ApplicationDB_FSCM**: Financials, Supply Chain Management, Project Management, Procurement, and Incentive Compensation
- **ApplicationDB_CRM**: Sales
- **ApplicationDB_HCM**: Human Capital Management

4. Perform steps 5 through 8 from the preceding Creating a Data Model task, as needed.

### Related Topics
- How You Set Up Reports to Run as Scheduled Processes
- How Data Is Structured for Analytics

## Create Reports

Create a report when the predefined reports don't provide the data you need. Or, if you want to use a predefined data model, and also want to change other aspects of the report other than layout. Save your report to **Shared Folders > Custom** in the business intelligence catalog. Saving content in the Custom folder is the only way to ensure that the content is maintained upon upgrade.

### Creating a Report

1. Open the Reports and Analytics work area, and .
2. Click click **New** and select **Report**.
3. Select the data model to use as the data source for your report.

   **Note**: Be sure that the data model you select has been validated. If you select a data model that has not been validated or has errors, when the report is run it will error indicating that the data model has not been validated or has an invalid status. To override this warning for a report, select the Ignore Data Model Validation Error option in the report properties.

4. Continue with the wizard to create the report layout, or choose to use the layout editor and close the wizard.
5. Define the layout for the report.
6. Click the **Properties** button in the report editor to set specific formatting, caching, and processing options for your report, including overriding data model validation errors.

### Setting Up Access

You or your administrator can:

- Create a job definition so that users can run your report as a scheduled process.
- Secure general access to your report and its job definition, if any.
Related Topics

- How You Set Up Reports to Run as Scheduled Processes
- Set Up Reports for Scheduling

Make Reports Available for Online Viewing

Some reports are set up so that you can only view them through another application or submit them as scheduled processes. To view your report online while you’re editing it, you must define a few settings. When you’re done editing your report, make sure that you reset these settings as needed.

Updating Report Properties

1. Select your report in the business intelligence catalog and click **Edit**.
2. In the report editor, click **Properties**.
3. In the Report Properties dialog box, select **Run Report Online** and deselect **Report is Controlled by External Application**.

Updating Layout Settings

1. Back in the report editor, click **View a list**.
2. Make sure that the **View Online** check box is selected.

Generating Sample Report Data: Procedure

Depending on the type of report layout changes you’re making, sample data can be required or optional. You generate sample data, and then load it for use with your layout so that you can map data fields to layout components. For example, for the Start Date table column in your layout, you can set it so that the data displayed in that column comes from the Start Date field in the sample data.

You can generate sample data from the:

- Report data model
- Report viewer
- Scheduler

Generating Sample Data from the Data Model

Follow these steps:

1. Select your data model in the business intelligence (BI) catalog and click **Edit**. Alternatively:
   a. In the catalog, find the report to generate sample data for and click **Edit**.
   b. Click the data model name in the report editor.
2. In the data model editor, click **View Data**.
3. Enter values for any required parameters, select the number of rows to return, and click **View**.
4. To save the sample data to the data model, click **Save As Sample Data**. If you’re designing a .rtf template, click **Export** to save the file locally.
5. Save the data model.
Saving Sample Data from the Report Viewer

For reports that are enabled for online viewing, you can save sample data from the report viewer:

1. Select the report in the BI catalog.
2. Click Open to run the report in the report viewer with the default parameters.
3. On the Actions menu, click Export, then click Data.
4. Save the data file.

Saving Sample Data from the Scheduler

For reports that are enabled for scheduling (not necessarily as a scheduled process), you can save sample data from the scheduler:

1. Select the report in the BI catalog.
2. Click Schedule.
3. On the General tab, enter values for any report parameters.
4. On the Output tab, ensure that Save Data for Republishing is selected.
5. Click Submit.
7. On the global header, click Open, then click Report Job History.
8. Select your report job name in the Job Histories table.
9. On the details page, under Output and Delivery, click the XML Data Download icon button.

Define the Number of Rows in Tables

The data model used for a report can determine the number of rows to display in specific tables on the report. To change that number, you can edit a copy of the predefined data model.

Copying the Data Model

To copy the predefined data model used for the report:

1. Click Navigator > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), find the predefined data model used for the report.
4. Click Copy in the toolbar.
5. In the BI catalog, expand Shared Folders > Custom and follow the same file path as the predefined data model outside the Custom folder. Create the corresponding folder structure in Custom if it doesn’t exist.

**Note:** All reports using the predefined data model are automatically redirected to point to your copied data model in the Custom folder. This applies:
- To all reports, predefined or not
- Only if the copied data model has the same name and relative file path in Custom as the predefined data model

6. Click Paste in the toolbar.

Modifying the Data Model

To edit the copied data model:

1. In the BI catalog, find your copied data model.
2. Click **Edit**.
3. In the Data Model pane, in Data Sets, select the data set that provides data for the table in the report.
4. On the Diagram tab, click the **Edit Selected Data Model** icon.
5. In the Edit Data Set dialog box, see if the last line in the **SQL Query** field starts with `FETCH FIRST`, for example `FETCH FIRST 500 ROWS ONLY`. Not all data sets have this row limit that you can edit.
6. Change the number in that line to the number of rows you want displayed in the table, for example, `FETCH FIRST 50 ROWS ONLY`.
7. Click **OK**.
8. Click the **Save** icon.

**Templates**

Create and Edit Report Layout Templates Using the Layout Editor

The layout editor in the application provides an intuitive, drag-and-drop interface for creating pixel-perfect reports with PDF, RTF, Excel, PowerPoint, and HTML output. The layout template files you create with this tool have an `.xpt` extension. The layout editor tool is the only editing tool that provides dynamic HTML output. Users can interact with this output in a browser, for example by sorting, applying filters, and so on.

**Prerequisite**

Make sure that sample data is generated from the data model that your report is using.

**Using the Layout Editor**

To create or edit XPT templates:

1. Select the report in the business intelligence (BI) catalog and click **Edit**.
2. In the report editor, click **Edit** to update a template.
   
   Or, click **Add New Layout** and select a template type in the Create Layout section.
3. Create or edit the layout.
4. Click **Save** to save the layout to the report definition.

**Set Up for RTF and Excel Report Layout Templates**

You can use Microsoft Word or Microsoft Excel to create or edit RTF and Excel layout templates, in addition to the layout editor in the application. If you use Word or Excel directly, you must download and install the appropriate add-in so that the Microsoft application has the features you need to design report layouts.

✍️ **Note:** If you’re designing a new layout for your report, consider using the layout editor instead unless you are an experienced layout designer.

**Installing the Add-In**

1. Open the Reports and Analytics work area.
2. Click the **Browse Catalog** button.
3. Click **Home**.
4. In the Get Started pane, click **Download BI Desktop Tools**.
5. Select the add-in for the type of template you’re working with.
   - **Template Builder for Word**: RTF templates
   - **Analyzer for Excel**: Excel templates

6. Save and then run the installer.

**Protecting Reports by Using Passwords**

You can assign a password to your report and protect it from unwanted access. You can do this by setting the runtime properties at the server level using the Runtime Configuration page. The same properties can also be set at the report level, from the report editor’s Properties dialog. If different values are set for a property at each level, then report level takes precedence.

The following table describes the properties you can use to set passwords for reports in different formats.

<table>
<thead>
<tr>
<th>Report Format</th>
<th>Property Name</th>
<th>Description</th>
<th>Default</th>
<th>Configuration Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCX output</td>
<td>Open password</td>
<td>Use this property to specify the password that report users must provide to open any DOCX report.</td>
<td>NA</td>
<td>docx-open-password</td>
</tr>
<tr>
<td>PPTX output</td>
<td>Open password</td>
<td>Use this property to specify the password that report users must provide to open any PPTX report.</td>
<td>NA</td>
<td>pptx-open-password</td>
</tr>
<tr>
<td>XLSX output</td>
<td>Open password</td>
<td>Use this property to specify the password that report users must provide to open any XLSX output file.</td>
<td>NA</td>
<td>xlsx-open-password</td>
</tr>
</tbody>
</table>

**Create and Edit RTF Report Layout Templates**

An RTF template is a rich text format file that contains the layout instructions to use when generating the report output. Use Microsoft Word with the Template Builder for Word add-in to design RTF templates.

**Prerequisites**

Install the Template Builder for Word add-in, and generate sample data.

**Using Template Builder for Word**

To modify an RTF template:

1. If you are editing an existing layout:
   a. Select your report in the business intelligence catalog and click **Edit**.
   b. In the report editor, click the **Edit** link of the layout to download the RTF file.
If you are creating a new layout, skip this step.

2. Open the downloaded RTF template file in Microsoft Word. Or, if you’re creating a new template, just open Microsoft Word.
3. Load the sample data that you generated.
4. Edit or create the layout template.
5. Save the file as Rich Text Format (RTF).

Change the Branding Logo in a Predefined Project Performance Reporting RTF Report Template

The Update Project Performance Data report layout includes a standard Oracle logo in the report header. You want to replace the Oracle logo with your own logo.

The following table summarizes the key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>What version of Microsoft Word are you using?</td>
<td>Microsoft Word 2007</td>
</tr>
<tr>
<td>What image do you want to use as your logo?</td>
<td>O_FusionApps_ProjectPortfolioMgmt_clr.gif</td>
</tr>
<tr>
<td>Which data model do you need to download sample report data from?</td>
<td>SummarizationDM</td>
</tr>
<tr>
<td>Do you want to preview the changed template?</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Prerequisite

1. Install the Template Builder for Word add-in, and download sample data (save it locally).

Changing the Logo

To change the logo in the report output:

1. Select the Update Project Performance Data Execution Report in the BI catalog and click Edit.
2. In the report editor, click the Edit link of the Update Project Performance Data Execution Report layout to download the RTF file.
3. Open the RTF file in Microsoft Word.
4. In the BI Publisher tab, click Sample XML in the Load Data group, and select sample data that was saved from the data model.
5. In the template, delete the Oracle logo and the text Fusion Projects and Project Performance Reporting.
6. On the Insert tab in the Illustrations group, click Picture.
7. Select the O_FusionApps_ProjectPortfolioMgmt_clr.gif file and insert it into the Word document.
8. Resize the image if you need to.
9. If the template file includes section breaks, you must insert the new logo for each section header.
10. In the Oracle BI Publisher tab, in the Preview group, click PDF. You can preview the PDF output that’s generated with the sample data that you loaded.
eText Report Layout Templates: Explained

An eText template is an RTF-based report template that is used for Electronic Funds Transfer (EFT) and Electronic Data Interchange (EDI). The template is applied to an input XML data file to create a flat text file that you transmit to a bank or other organizations. Use Microsoft Word to create or edit eText templates.

File Format

Because the output is for electronic communication, not printing, you must follow specific format instructions for exact placement of data on the template. You design eText templates using tables.

- Each record is represented by a table.
- Each row in a table corresponds to a field in a record.
- The columns of the table specify the position, length, and value of the field.

Special Commands

You must set up special handling of the data from the input XML file. This table describes the two levels of handling and where you declare the corresponding commands.

<table>
<thead>
<tr>
<th>Level</th>
<th>Example</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Character replacement</td>
<td>Declare global commands in separate setup tables.</td>
</tr>
<tr>
<td></td>
<td>Sequencing</td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>Sorting</td>
<td>Declare functions in command rows, in the same table as the data.</td>
</tr>
</tbody>
</table>

Upload the Layout Template File to the Report Definition

If you’re creating or editing a report layout using the layout editor, the layout is automatically saved to the report definition, so you can skip this step. For all other layout types, for example RTF, upload the template file to the report definition after you’re done making layout changes.

Uploading the Template File

1. Select your report in the business intelligence catalog and click Edit.
2. In the report editor, click View a list.
3. In the table that lists the layouts, click Create.
4. Click Upload in Upload or Generate Layout.
5. In the Upload Template File dialog box:
   a. Enter a layout name.
   b. Browse for and select the layout template file that you created or edited.
   c. Select the template file type.
   d. Select the locale, which you can’t change once the template file is saved to the report definition.
Configure Layout Settings for Reports

As part of creating or editing layout, you can set report properties related to layout. These settings determine, for example, which layouts users can choose from when viewing or scheduling the report. The settings apply only to your report.

Setting Layout Properties

1. Select your report in the business intelligence catalog and click **Edit**.
2. In the report editor, click **View a list**.
3. Set layout properties, some of which are described in this table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Formats</td>
<td>Depending on the requirements for a report, you may want to limit the output file formats (for example, PDF or HTML) that users can choose. The available output formats vary depending on the template file type.</td>
</tr>
<tr>
<td>Default Format</td>
<td>When multiple output formats are available for the report, the default output format is generated when users open the report in the report viewer.</td>
</tr>
<tr>
<td>Default Layout</td>
<td>When multiple layouts are available for the report, you must select a default layout to present it first in the report viewer.</td>
</tr>
<tr>
<td>Active</td>
<td>Active layouts are available for users to choose from when they view or schedule the report.</td>
</tr>
<tr>
<td>View Online</td>
<td>Select this check box so that layouts are available to users when they view the report. Otherwise, the layout is available only for scheduling the report.</td>
</tr>
</tbody>
</table>

4. Click **Save Report**.

Configure Email Notifications

Overview of Financials Configurable Workflow Notifications

The Financial applications, as part of certain business flows, automatically send notifications for review or approval. For example, when a user submits an expense report, the approvers receive an email containing the approval request. Oracle Business Intelligence (BI) Publisher reports are used for some flows to generate the content and format. You can enable BI Publisher-based notifications, which are ready to use as delivered. The notification templates can be easily configured to meet other specific requirements. If required, you can change the delivered template layouts and content, to add images, change colors and styling, add or remove attributes or modify text.

The following table shows the financial products that use configurable notifications, along with their associated features, and workflow task names:
<table>
<thead>
<tr>
<th>Product</th>
<th>Feature Name</th>
<th>Report or Notification Name</th>
<th>Workflow Task Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Ledger</td>
<td>Journal Approval Notifications</td>
<td>Journal Approval Report</td>
<td>FinGlJournalApproval</td>
</tr>
<tr>
<td>Payables</td>
<td>Invoice Approval Notifications</td>
<td>Invoice Approval Report</td>
<td>FinApInvoiceApproval</td>
</tr>
<tr>
<td>Payables</td>
<td>Hold Resolution Notifications</td>
<td>Hold Resolution Notification</td>
<td>FinApHoldResolutionApproval</td>
</tr>
<tr>
<td>Payables</td>
<td>Payment Approval Notifications</td>
<td>Payment Approval Notification</td>
<td>PaymentApproval</td>
</tr>
<tr>
<td>Payables</td>
<td>Invoice Account Coding Notifications</td>
<td>Invoice Account Coding Email Notification</td>
<td>FinApInvoiceAccountCoding</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Report Approval Notifications</td>
<td>Expense Report Approval Notification</td>
<td>FinExmWorkflowExpenseApproval</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Reimbursement Notifications</td>
<td>Reimbursement Paid to Card Issuer Notification</td>
<td>FinExmReimToCardIssuerFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Reimbursement Notifications</td>
<td>Reimbursement Paid by Check Notification</td>
<td>FinExmReimToEmpByCheckFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Reimbursement Notifications</td>
<td>Reimbursement Paid by Direct Deposit Notification</td>
<td>FinExmReimToEmpByDepositFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Expense Report Adjusted by Auditor Notification</td>
<td>FinExmExpenseAuditFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Expense Report Rejected by Auditor Notification</td>
<td>FinExmExpenseAuditFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Pending Payment with Warnings Notification</td>
<td>FinExmReceiptManagementFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Expense Report Returned by Auditor Notification</td>
<td>FinExmReportShortpaidReceiptIssue</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Short-Paid Report with Noncompliance Notification</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>Cash Advance Notifications</td>
<td>Cash Advances Approval Notification</td>
<td>FinExmWorkflowCashAdvanceApproval</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Payment is Held Notification</td>
<td>FinExmReceiptManagementFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Payment is Released Notification</td>
<td>FinExmReceiptManagementFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Reimbursement Notifications</td>
<td>Reimbursement Has Been Paid to Employer Notification</td>
<td>FinExmReimToEmpByCheckFyi</td>
</tr>
<tr>
<td>Product</td>
<td>Feature Name</td>
<td>Report or Notification Name</td>
<td>Workflow Task Name</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Mileage Adjustment Notification</td>
<td>ExpenseAuditMileageAdjustmentFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Missing Receipt Declaration is Required Notification</td>
<td>FinExmReceiptManagementFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Cash Advances Notifications</td>
<td>Overdue Cash Advance Notification</td>
<td>FinExmWorkflowOverdueNotification</td>
</tr>
<tr>
<td>Expenses</td>
<td>Cash Advances Notifications</td>
<td>Cash Advances Automatically Applied Notification</td>
<td>FinExmWorkflowCashAdvanceAutoAppliedFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Inactive Employee’s Outstanding Transactions Notification</td>
<td>FinExmInactiveEmployeeSubmitExpenseFyi</td>
</tr>
<tr>
<td>Expenses</td>
<td>Expense Audit and Receipt Management Notifications</td>
<td>Inactive Employee-Accept Responsibility Notification</td>
<td>FinExmInactiveEmployeeAcceptResp</td>
</tr>
<tr>
<td>Intercompany</td>
<td>Intercompany Email Notifications</td>
<td>Intercompany Transaction Approval Notification</td>
<td>FinFunTransactionApproval for Intercompany Transaction Approval Notification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intercompany Enter Receiver Distribution Notification</td>
<td>FinFunEnterDistRequestForAction for Intercompany Enter Receiver Distribution Notification</td>
</tr>
<tr>
<td>Bill Management</td>
<td>User Registrations Notifications</td>
<td>Registration Confirmation.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New Account Registration Confirmation.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Account Access Revocation Notification.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Access Revocation Notification.</td>
<td></td>
</tr>
<tr>
<td>Budgetary Control</td>
<td>Budgetary Control Override Email Notifications</td>
<td>Budget Override Request Notification Budget</td>
<td>OverrideNotificationFyi</td>
</tr>
<tr>
<td>Budgetary Control</td>
<td>Budgetary Control Override Email Notifications</td>
<td>Override Taken Notification</td>
<td>OverrideNotificationFyi</td>
</tr>
<tr>
<td>Receivables</td>
<td>Manual Credit Memo Request Notification</td>
<td>Manual Credit Memo Request Notification</td>
<td>FinArTrxnsCreditMemosCreationPostProcessing</td>
</tr>
</tbody>
</table>

**Note:** The in-app notification is also configurable.
Note: When you receive a workflow email notification, you can alternatively find the same notification by clicking the Notifications icon in the global header or opening the Worklist: Notifications and Approvals work area. Your report edits don’t affect the other notification methods.

Process Overview
Generating configurable notifications through BI Publisher involves various types of objects in the BI catalog, including data models, subtemplates, style templates, and reports. Reports pull data from data models and generate notifications in an HTML format. The report layout templates use common table and paragraph styles and refer to a central subtemplate that contains reusable notification components. This figure shows how these BI objects work together to generate the notification content.

- **Data Sources**: Store the attributes and attribute values for business objects and transactions in the application (example of data sources being transaction tables)
- **Data Model**: Determines which attributes from data sources are available to be included in the notification and how that data is retrieved
- **Subtemplate**: Provides common components, such as a branding logo and buttons, that can be reused in multiple reports.
- **Style Template**: Provides styles such as the type of lines and fonts to use in tables, or the font type, size, and color to use for headings
- **Report**: Contains a layout template that determines:
  - Which attributes appear in the notification, from the data model used for the report
  - What the notification looks like, leveraging components from the subtemplate and styles from the style template used for the report
- **HTML**: Format of the output generated by the report
- **Email**: What the notification looks like, leveraging components from the subtemplate and styles from the style template used for the report
• In-App Notification: Has the HTML output embedded in the application UI

Each workflow task with configurable notifications has a corresponding predefined report in the BI catalog. For example, the Invoice Approval report contains the Invoice Approval Notifications report layout template and uses the Invoice Approval Data Model.

Notification Modifications

When you enable configurable email notifications, the predefined reports and related objects in the BI catalog will be used to generate the email notifications. The report-based notifications provide the same information as the standard notifications. In addition, the format of report-based notifications is optimized for mobile devices. To modify the email notifications, you can edit copies of the predefined reports, data models, and subtemplate. However, you can’t change the style template. You proceed as you would to edit any report, data model, or subtemplate in the catalog, for example:

1. Find a predefined report for expense approval in the BI catalog.
2. Use the Customize option to create a copy, or copy the report and paste it within the Custom folder.
3. Edit the copied report layout template.

Before modifying workflow email notifications, it’s recommended that you familiarize yourself with BI Publisher in general. This will improve your ability to change your notifications by formatting emails to meet your business requirements.

With BI Publisher-based email notifications you:

• Use only the Template Builder for Word add-in to edit the .rtf template in Microsoft Word, rather than the layout editor or other tools available for creating and editing report layout.
• Edit a copy of predefined layout templates, rather than creating reports or layout templates.

Note: Review the My Oracle Support (MOS) note: Configurable Workflow Notifications: Implementation Considerations (Doc ID 2215570.1).

Steps to Enable

In the Offerings work area, enable the Configurable Email Notifications feature as follows:

1. Offering: Financials
2. Functional Area: Budgetary Control, Expenses, Intercompany, General Ledger, or Payables
3. Feature: Configurable Email Notifications
4. Choices: The specific notifications you want to enable
5. Click Done.

Add a Branding Logo and Change Other Shared Components in Workflow Notifications

A predefined subtemplate contains common components for all workflow notifications based on predefined report layouts. For example, the subtemplate has a place for you to add a branding logo, which would appear at the beginning of email notifications. You can modify other shared components so that the same changes apply to your notifications. For example, for email notifications, you can also change the text on action buttons, or the text of the links that appear at the end of emails.
Note:
- You must edit a copy of the subtemplate in the Custom folder of the business intelligence (BI) catalog. Don’t directly update the predefined subtemplate.
- The exact steps can vary depending on your version of Microsoft Word.

Modifying Shared Components in the Subtemplate
To edit a copy of the predefined subtemplate that contains the shared components:

1. Click Navigator > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), expand Shared Folders > Common Content > Templates.
4. For Workflow Notification Subtemplate, click More and select Customize.

If you’re not using the Customize option:
   a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
   b. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates. Create a Templates folder in this location if it doesn’t exist.
   c. Click Paste in the toolbar.
   d. Click the Edit link for the copied subtemplate.

All reports using the predefined subtemplate are automatically redirected to point to your subtemplate in the Custom folder. This applies:
   - To all reports, predefined or not
   - No matter if you copy and paste the subtemplate or use the Customize option
   - Only if your subtemplate has the same name and relative file path within Custom as the predefined subtemplate

5. In the Templates section, click the link in the Locale column.
6. Save the subtemplate .rtf file to your computer.
7. Open the .rtf file with Microsoft Word.
   - To add a logo, insert your own image in the subtemplate.
   - To change button or link text, edit the text accordingly. Make the same edits wherever that button or link text appears in the subtemplate.

Caution: To ensure that your layout templates reflect these changes without additional rework, don’t edit any other text in the subtemplate .rtf file.

8. Update Word options to ensure that existing links remain intact in the subtemplate.
   a. Click File > Options > Advanced.
   b. In the Word Options dialog box, click Web Options in the General section.
   c. In the Web Options dialog box, open the Files tab.
   d. Deselect the Update links on save check box.
9. Save your changes in Word.
Uploading the Modified Subtemplate

To upload your subtemplate to the BI catalog:

1. In the BI catalog, expand **Shared Folders > Custom > Common Content > Templates**.
2. Click **Edit** for Workflow Notification Subtemplate.
3. In the Templates section, click the **Upload** icon.
4. Select your modified .rtf subtemplate and a locale, and click **OK** to overwrite the original subtemplate.

**Related Topics**
- Subtemplates

Best Practices for Layouts in Workflow Notifications

Predefined workflow notifications based on report layout templates all follow a general format. When you edit a copy of these layout templates in Microsoft Word, follow the predefined layout as closely as possible for consistency. Also keep in mind shared components and mobile considerations.
General Structure
In general, the workflow notifications contain a set of components that are displayed in a certain order. The callouts in this figure identify the email notification components listed in the following table.

The callouts in this figure identify the in-app notification components listed in the following table. In addition to describing each component, the table also indicates if the component appears in the email notification, in-app notification, or both.
<table>
<thead>
<tr>
<th>Callout</th>
<th>Component</th>
<th>Notification Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Buttons with the primary actions to take on the task, such as <strong>Approve</strong> and <strong>Reject</strong>. These buttons aren’t part of the configurable, report-based notification content.</td>
<td>In-app</td>
</tr>
<tr>
<td>2</td>
<td>Notification header listing key attributes of the workflow task and the associated transaction.</td>
<td>Both</td>
</tr>
<tr>
<td>3</td>
<td>Buttons for the primary actions to take on the task, such as <strong>Approve</strong> and <strong>Reject</strong>.</td>
<td>Email</td>
</tr>
<tr>
<td>4</td>
<td>Notification body that usually includes transaction and line level details, displayed in tables or sets of attributes with corresponding values. The data model for the report restricts the total number of rows displayed in some of the tables. If the limit is exceeded, the table footer provides a link to the transaction details page, where users can view all the rows. To change this limit, you can edit a copy of the data model.</td>
<td>Both</td>
</tr>
<tr>
<td>5</td>
<td>Approval history, including any attachments that users in the history uploaded for the task. You can’t edit the approval history</td>
<td>Email (or both, in rare cases)</td>
</tr>
</tbody>
</table>
Callout | Component | Notification Type
--- | --- | ---
6 | Component, which usually appears in the body of only email notifications. For in-app notifications, you can usually view the history by clicking the Actions button and selecting History. | Email
7 | Buttons for the primary actions again. | Email

When you modify notifications, try to keep to this general structure and don’t remove essential elements such as the action buttons. Likewise, don’t change the styles in your layout template. The predefined style template should still apply to your notification; don’t edit a copy of the style template and apply that to your notification.

To add components to your notification, for example another table, consider first downloading another style template from My Oracle Support. This template contains Quick Parts content that you can use in Word when you do more advanced work on layout templates. For example, from the Quick Parts gallery, you can select and add the table that’s consistent in format with predefined tables already on your notification.

By default, the components that you add in the layout template appear in both email and in-app notifications, where available. You can add conditions to explicitly make a particular element, for example a field, appear only in one type of notification and not the other.

**Shared Components**

A predefined subtemplate in the business intelligence (BI) catalog applies to all predefined layout templates for workflow notifications. The subtemplate contains components that are shared among the notifications, for example:

- Branding logo, if you add one to the subtemplate, which would appear as the first component in the email body. The logo appears in email notifications only.
- Action buttons in email notifications.
- Links at the end of the email notification, one to the corresponding transaction page, and another to the in-app notification.

When you make a copy of a predefined layout template to edit, the copy automatically inherits the same predefined subtemplate. To edit these shared components, make a copy of the predefined subtemplate, edit the copied version, and apply it to your own layout templates.

**Mobile Considerations**

Because users can view the workflow notifications on mobile devices, always consider mobile first and keep the notifications as simple as possible. For example:

- Don’t put too much content horizontally, such as too many columns in tables.
- Keep all text, including attributes and column headings, as short as possible.
- Center align lists of attributes and their values, if they appear outside tables.

Make sure to test your email notifications on mobile devices.

**Related Topics**

- Subtemplates
Preview Changes to Layout Templates for Workflow Notifications

To modify workflow notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word. Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the notifications sent to users.

Note: The exact steps can vary depending on your version of Microsoft Word.

Prerequisites

- Generate sample report data from the data model used for the report, and save the .xml file to your computer.
- Download a local copy of the subtemplate that applies to your own report layout template:
  
  a. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates if you’re using a modified subtemplate, or Shared Folders > Common Content > Templates for the predefined subtemplate.
  b. Click Edit for Workflow Notification Subtemplate.
  c. In the Templates section, click the link in the Locale column.
  d. Save the subtemplate .rtf file to your computer.

Previewing Output

To generate sample output from a local layout template:

1. Open your .rtf report layout template in Microsoft Word and make your edits.
2. On the ribbon, open the BI Publisher tab and click Sample XML within the Load Data group.
3. Select the .xml file you downloaded to import sample data from the data model.
4. At the beginning of your .rtf document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change `<?import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>`.
5. From the BI Publisher tab on the ribbon, click HTML in the Preview group.
6. If the preview reflects your changes as expected, then change the path back to the original location.
7. From the BI Publisher tab on the ribbon, click Validate Template in the Tools group.
8. Also in the Tools group, click Check Accessibility.
9. Save your changes in Word.

Use Quick Parts for Workflow Notifications

Use the Quick Parts feature in Microsoft Word to easily insert reusable pieces of formatted content. When you edit copies of predefined report layout templates for workflow notifications in Word, you can add predefined Quick Parts content to your .rtf file. For example, you can insert a table in a format that’s consistent with predefined notifications. The predefined Quick Parts content is available in a style template .dotx file on My Oracle Support.

Note: The exact steps can vary depending on your version of Microsoft Word.
Prerequisites
To get the predefined Quick Parts content into your Quick Parts gallery:

2. Download the .dotx file and save it to your Microsoft Word template folder, for example C:\Users\<user name>\AppData\Roaming\Microsoft\Templates.

Also, to preview your layout template changes before uploading the .rtf file back to the business intelligence (BI) catalog:

- Generate sample report data from the data model for the report that you’re editing.
- Download a local copy of the subtemplate that applies to the layout template.

Adding Quick Parts Content to Workflow Notifications
To insert content from the Quick Parts gallery into a layout template:

1. In the BI catalog, find the predefined report with the layout template that you want to modify.
2. For the report, click More and select Customize.
   If you’re not using the Customize option:
   a. Copy the predefined report and paste it in an appropriate subfolder within the Custom folder.
   b. Click the Edit link for the copied report.
3. Click Edit for the layout template to insert Quick Parts content into, and save the .rtf file to your computer with a new file name.
4. Open the .rtf file with Microsoft Word.
5. Put your cursor where you want to insert new content.
6. From the Insert tab on the ribbon, click Quick Parts within the Text group, and select the component to insert.
7. Edit the inserted component as needed and add any other components.
8. Save your changes in Word.

Previewing the Layout Template Changes
To preview your edits before uploading your layout template to the BI catalog:

1. On the ribbon, open the BI Publisher tab and click Sample XML within the Load Data group to import sample data from the data model. Skip this step if you already loaded sample data.
2. At the beginning of the document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change "<?import:xdoxs1://Common Content/Templates/Workflow Notification Subtemplate.xsb?>" to "<?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>".
3. From the BI Publisher tab on the ribbon, click HTML in the Preview group.
4. If the preview reflects your changes as expected, then change the path back to the original location.
5. Save your changes in Word.

Uploading the Modified Layout Template
To upload your layout template to the BI catalog after previewing the changes:

1. Back in the BI catalog, click Edit for the report within the Custom folder, if that page isn’t still open.
2. Click the View a list link.
3. Click the Create icon on the table toolbar.
4. In the Upload or Generate Layout section, click Upload.
5. Upload your edited .rtf file with a unique layout name.
6. Back on the page for editing the report, click Delete for the layout template that you downloaded earlier.

7. Click the **Save Report** icon.

**Related Topics**

- Configurable Email Notifications: Implementation Considerations
- Style Templates

---

**Modify Journal Approval Email Notifications Using Oracle Business Intelligence (BI) Publisher**

This example shows how to modify email notifications for the journal approval workflow using BI Publisher reports. The following table summarizes the key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>What text changes are needed in the email notification header?</td>
<td>Append the fiscal year.</td>
</tr>
<tr>
<td>What additional field should the email notification header include?</td>
<td>The name of the user who created the journal batch.</td>
</tr>
<tr>
<td>What changes are needed in the details section of the email notification?</td>
<td>Replace the values of the cost center and account segments with the descriptions for those segments. The chart of accounts has the following segments: Company, Cost Center, Account, Product.</td>
</tr>
</tbody>
</table>

Modify the journal approval email notification by:

1. Downloading the report layout template.
2. Copying and modifying the data model. This step is only needed if the attributes to be added to the email notification aren’t already present in the data model.
3. Exporting the data model. You must perform this step even if you didn’t make changes to the data model. This step is needed for previewing.
4. Editing the report layout template.
5. Previewing the modified email notification.
6. Uploading the modified report layout template.

For more information about configuring BI Publisher email notifications, see the Reports chapter in the Creating Analytics and Reports for Financials Cloud guide.

**Prerequisites**

1. To edit the report layout template, download and install Template Builder for Word, which is an extension to Microsoft Word.
   a. Sign in to the application with the application consultant job role.
   b. In the Reports and Analytics work area, click the **Browse Catalog** button.
   c. Click the **Home** link.
   d. In the Get Started section, click the **Download BI Desktop Tools** link.
   e. Select **Template Builder for Word** from the list.
   f. Save the file and run the installer.
2. To preview the notification output for your modified report layout template, you must first download a copy of the Workflow Notification Subtemplate.
   a. Click the Catalog link on the Oracle Business Intelligence home page and expand the Shared Folders > Common Content > Templates folder.
   b. Click the Edit link for the Workflow Notification Subtemplate. The subtemplate page opens.
   c. In the Templates section, click the language name link in the Locale column.
   d. Save the subtemplate .rtf file to your computer.

3. The predefined data model displays the account combination, which is based on segment values, on the journal approval email notification. To display a combination of segment values and descriptions on the email notification, identify the segment codes for all of the chart of account segments. The segment codes are used in the task Copying and Modifying the Data Model.
   a. In the Setup and Maintenance work area, go to the following:
      - Offering: Financials
      - Functional Area: Financial Reporting Structures
      - Task: Manage Chart of Accounts Structure
   b. Search for the Accounting Flexfield and click Manage Structures to open the Manage Key Flexfield Structures page.
   c. Search for your chart of accounts and click Edit in the Search Results section.
   d. Find the segment code values for all of the segments in the Segment Code column. In this example, the segment codes are VF_Company, VF_Cost_Center, VF_Account, and VF_Product.

4. Find an existing journal approval email notification and note the values for the following attributes: accounting period, journal batch name, and ledger name. This information is used to produce sample report data for the task Exporting the Data Model.

   Note: The exact steps can vary depending on your version of Microsoft Word.

Downloading the Report Layout Template

The report layout template contains the structure of the email notification. To download a copy of the journal approval report layout template to your local drive for modification:

1. Sign in to the BI server (for example, http://hostname.com:7001/xmlpserver) with the application consultant job role to open the Oracle Business Intelligence home page.
2. Click the Catalog link to open the Catalog page.
3. In the Folders pane, expand the Shared Folders > Financials > Workflow Notifications > General Ledger folder.
4. Click the Journals folder to display the Data Models subfolder and the Journal Approval Report.
5. Click the More link for the Journal Approval Report, and then select Customize from the menu. The Journal Approval Report folder, containing the predefined report layout template, is automatically copied to the Custom folder and the Journal Approval Report page opens from within that folder.

   Note: If the Customize option isn’t available from the menu, check that you signed in to the BI server as mentioned in step 1.

6. Click the Edit link on the copy of the Journal Approval Email Notification report layout template.
7. Save the copy of the .rtf file to your local drive and change the file name to distinguish it from the predefined report layout template. For example, save the file as UpdatedJournalApprovalNotificationReport.rtf.

   Caution: Be sure to change the name of the .rtf file, otherwise you could overwrite the predefined report layout template.
Copying and Modifying the Data Model
Always make a copy of the data model to preserve the predefined data model from errors and to have a data model to which you can revert. Modify the copy to add or remove attributes from the data model. In this example, you modify the data model to include either a segment value or a segment description for each segment in the chart of accounts.

1. To copy the data model:
   a. Click the Catalog link on the Oracle Business Intelligence home page to open the Catalog page.
   b. In the Folders pane, expand the Shared Folders > Financials > Workflow Notifications > General Ledger folder.
   c. Click the Journals folder to display the Data Models subfolder and the Journal Approval Report.
   d. In the Folders pane, click the Data Models subfolder to select it.
   e. In the toolbar, click the Copy Resource button.
   f. In the Folders pane, expand the Shared Folders > Custom > Financials > Workflow Notifications > General Ledger folder.
   g. Click the Journals folder to select it.
   h. In the toolbar click the Paste Resource button to create a copy of the Data Models folder.

   Note: The Journal Approval Report is automatically redirected to use the copy of the data model in the Custom folder.

2. Use a text editor to construct the SQL statement for each segment in the chart of accounts to display either a value or a description.
   a. Use this statement as a template for displaying a segment value:
      \[
      \text{FUN_BIP_UTIL_PKG.get_seg_value_from_code(lines.CODE_COMBINATION_ID,'Segment_code') as Segment_Val}
      \]
      Use this statement as a template for displaying a segment description:
      \[
      \text{FUN_BIP_UTIL_PKG.get_seg_description_from_code(lines.CODE_COMBINATION_ID,'Segment_Code') as Segment_Desc}
      \]
   b. Replace the \text{Segment_code} value in each statement with the segment codes from your chart of accounts.
   c. Replace the \text{Segment_Val} or \text{Segment_Desc} values at the end of each statement with a user-defined term for that segment.

   Note: The user-defined terms are added to the report layout template as part of the task Editing the Report Layout Template.

The following table shows the segment names, segment codes, and prepared SQL statements for each segment in the chart of accounts. Each SQL statement includes the segment code and ends with the user-defined term representing the segment and indicating whether it’s a value or a description. For example, the SQL statement for the cost center ends with \text{CostC_Desc}. Each statement ends with a comma.

<table>
<thead>
<tr>
<th>Segment Name</th>
<th>Segment Code</th>
<th>SQL Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>VF_Company</td>
<td>FUN_BIP_UTIL_PKG.get_seg_value_from_code(lines.CODE_COMBINATION_ID,'Segment_code') as Company_Value,</td>
</tr>
<tr>
<td>Cost Center</td>
<td>VF_Cost_Center</td>
<td>FUN_BIP_UTIL_PKG.get_seg_description_from_code(lines.CODE_COMBINATION_ID,'Segment_Code') as CostC_Desc</td>
</tr>
<tr>
<td>Segment Name</td>
<td>Segment Code</td>
<td>SQL Statement</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Account</td>
<td>VF_Account</td>
<td><code>FUN_BIP_UTIL_PKG.get_seg_value_from_code(lines.CODECOMBINATION_ID'VF_Account') as Account_Desc,</code></td>
</tr>
<tr>
<td>Product</td>
<td>VF_Product</td>
<td><code>FUN_BIP_UTIL_PKG.get_seg_value_from_code(lines.CODECOMBINATION_ID'VF_Product') as Product_Value,</code></td>
</tr>
</tbody>
</table>

### 3. To edit the copy of the data model:

- **a.** Find your copy of the data model by expanding the **Shared Folders > Custom > Financials > Workflow Notifications > General Ledger > Journals > Data Models** folder.
- **b.** Click the **Edit** button for the Journal Approval Data Model copy. The Journal Approval Data Model page opens.
- **c.** In the Data Model pane, in the **Data Sets** folder, click the **Journal Lines** data set.
- **d.** On the Diagram tab, click the **Edit Selected Data Set** button. The Edit Data Set - Journal Lines dialog box opens with the SQL query for the Journal Lines data set.

The following figure shows the Edit Data Set - Journal Lines dialog box with the predefined SQL query.

![Edit Data Set - Journal Lines dialog box](image)

- **e.** In the **SQL Query** field, place your cursor after **SELECT** and insert rows for the new SQL statements.
f. Copy the SQL statements that you prepared in step 2 into the **SQL query** field after the word **SELECT** and before the `lines.JE_HEADER_ID HDR_ID`

The following figure shows the Edit Data Set - Journal Lines dialog box with the new SQL statements.

![Edit Data Set - Journal Lines](image)

- g. Click **OK** to close the Edit Data Set - Journal Lines dialog box.
- h. Click the **Save** button to save the modified copy of the data model.

**Exporting the Data Model**

To add fields from the data model to your copy of the report layout template, you must first export the modified data model .xml file.

1. Click the **Catalog** link on the Oracle Business Intelligence page to open the Catalog page.
2. In the **Folders** pane, expand the **Shared Folders > Custom > Financials > Workflow Notifications > General Ledger > Journals** folder.
3. Click the Data Models folder to display the modified Journal Approval Data Model.
4. Click the **Edit** link for the data model. The data model page opens on the Diagram tab.
5. Click the Data tab.
6. To export the full data model .xml file, click in each of these fields and enter values from an existing journal approval email notification: **Accounting Period**, **Journal Batch Name** and **Ledger Name**.
7. To include empty fields in the data model export, click the **Properties** link in the Data Model pane.
8. On the Properties page, select the **Include Empty Tags for Null Elements** option.
9. Click **Save**.
10. In the Data Model pane, click the **Data Sets** link to return to the Data tab.
11. Click the **View** button to view the sample data.
12. Click the **Export** button and save the Journal Approval Data Model .xml file to a local drive.
13. Repeat step 7 to return to the Properties page and deselect the **Include Empty Tags for Null Elements** option.
Note: If you leave this option selected, performance issues could result.

14. Click **Save**.

**Editing the Report Layout Template**

Edit the copy of the report layout that you downloaded earlier in the task **Downloading the Report Layout Template**.

1. To append the fiscal year to the email notification header:
   a. Open your local copy of the report layout template using Microsoft Word.
   b. Place your cursor at the end of the default header text, which is *Journal Batch Approval*.
   c. Add a space and enter the text *Fiscal Year 2017 - 2018*. The header now says *Journal Batch Approval Fiscal Year 2017 - 2018*.

   The following figure shows the modified email notification header.

2. To add the name of the user who created the journal batch to the email notification:
   a. Select the BI Publisher tab to open the BI Publisher ribbon.
   b. In the **Load Data** group on the ribbon, click **Sample XML**.
   c. On the XML data selection dialog box, select the .xml file that you saved in step 11 of the task **Exporting the Data Model**. Click **Open**.
   d. Click **OK** on the message that appears indicating that the data was successfully loaded.
   e. In the header section of the report layout template, place your cursor at the end of the BATCH_SOURCE field, and insert a new line.
   f. Enter the text label for the new field, such as *Batch Created By*, and then add a space.
   g. In the **Insert** group on the BI Publisher ribbon, click the **Field** button. The Field dialog box opens with a list of the data model fields.
   h. In the JOURNAL_BATCH folder, select the BATCH_CREATOR field and click **Insert**. The field is automatically added to the header section after the new text label.
   i. On the **Field** dialog box, click **Close**.
The following figure shows the modified email notification header.

![Modified Notification Header](image)

3. To replace the account combination ID fields on the report layout template with the segment values and descriptions that were added to the data model:
   a. Place your cursor after the label called `StrtLineLINE_ACCOUNTEC` and insert a new line.
   b. In the Insert group on the BI Publisher ribbon, click the `Field` button. The Field dialog box opens with a list of the data model fields.
   c. In the Journal Lines folder, select the `COMPANY_VALUE` field. The name for this field is the user-defined name for the company segment from the task **Copying and Modifying Data Model**.
   d. Click **Insert** to add the field to the report layout template.
   e. Select the rest of the segments from the Field dialog box and insert them into the report layout template with a separator between each segment.

   The following figure shows the modified notification with the account segments.

![Modified Notification with Account Segments](image)

g. Format the segments that were added by copying the format from the `CLINE_ACCOUNTEC` field in the report layout template. Click the `CLINE_ACCOUNTEC` field.
Click the Home ribbon, select the **Format Painter** button, and select the segments that were added. For example, select `COMPANY_VALUE-COSTC_DESC-ACCOUNT_DESC-PRODUCT_VALUE`.

Place your cursor after the `CLINE_ACCOUNT` field and insert a new line.

Copy the account line that you created in the previous steps of this section and paste it into the new line.

The following figure shows the modified notification with the account segments appearing after both the `StrtLine_LINE_ACCOUNT` and the `CLINE_ACCOUNT` fields.

```
StrtLine_LINE_ACCOUNT
COMPANY_VALUE COSTC_DESC ACCOUNT_DESC PRODUCT_VALUE
StrtNullENTERED_LINE_Amount
EndNull_EnuLine_CURR_CODEEndNullStartMulti
RateText RATE_DATEEndMultiC
LINE_DESC
CLINE_ACCOUNT
COMPANY_VALUE COSTC_DESC ACCOUNT_DESC PRODUCT_VALUE
LINE_DESC
```

Delete the fields `StrtLine_LINE_ACCOUNT` and `CLINE_ACCOUNT` from the report layout template.

Click **Close** on the Field dialog box.

4. Save your local copy of the report layout template.

**Previewing the Modified Email Notification**

Before uploading your modified report layout template to the BI catalog, you should preview the output with the changes that you made. You can avoid uploading a broken report that displays an error in emails sent to users.

1. Replace the path at the beginning of the modified `.rtf` template with the location of the subtemplate that you downloaded as a prerequisite. For example, change `<?import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>`.

   Note: Save the original path information so you can copy it back after previewing.

2. In the Preview group on the BI Publisher ribbon, click **HTML**.
The following figure shows an example of how the account combination appears in the preview. The value for the company segment is 31111. The segment description for cost center is R&D US. The description for the account segment is White Wine Revenue, and the value for the product segment is 0000.

3. If the preview reflects your changes as expected, then change the subtemplate path in the .rtf file back to the original location.
4. In the Tools group on the BI Publisher ribbon, click Validate Template.
5. Save the modified report layout template.

### Uploading the Modified Report Layout Template

To use the modified report layout template for future journal approval email notifications:

1. Click the Catalog link on the Oracle Business Intelligence home page to open the Catalog page.
2. In the Folders pane, expand the Shared Folders > Custom > Financials > Workflow Notifications > General Ledger folder.
5. Click the View a list link to open the Layout page.

**Tip:** The Layout page displays the copy of the predefined report layout template that was automatically created in step 5 of the task Downloading the Report Layout Template. If you’re not satisfied with your changes, you can revert back to this copy by making it the default layout. (Refer to step 11.) Alternatively, you can revert back to the predefined report layout template by deleting the Journal Approval Report folder from the directory Shared Folders > Custom > Financials Workflow Notifications > General Ledger.

6. Click the Create button. A page opens with a Create Layout section and an Upload or Generate Layout section.
7. In the Upload or Generate Layout section, click the Upload button. The Upload Template File dialog box opens.
8. Complete the fields, as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Name</td>
<td>Enter a name for the modified report layout template. For example, enter Modified Journal Approval Template.</td>
</tr>
<tr>
<td>Template File</td>
<td>Click Browse. Locate and select the modified report layout template that’s on your local drive. Click Open to return to the Upload Template File dialog box.</td>
</tr>
<tr>
<td>Type</td>
<td>RTF Template</td>
</tr>
<tr>
<td>Locale</td>
<td>English</td>
</tr>
</tbody>
</table>
9. Click **Upload**. The Journal Approval Report page returns to the thumbnail view and displays the report layout template that you just uploaded, along with the original copy.

10. Click the **View a list** link to return to the Layout page with the list of the report layout templates.

11. In the row for the report layout template that you just uploaded, click the **Default Layout** option. This step enables the modified report layout template for future journal approval email notifications.

12. Click the **Save** button to save the change to the default layout.

**Related Topics**

- Creating Analytics and Reports for Financials Cloud

**Example of Modifying Expenses Email Notifications Using Oracle Business Intelligence Publisher**

This example shows you how to modify the Expense Report Approval email notification template using Oracle Business Intelligence (BI) Publisher templates.

The following table summarizes questions to consider for this scenario.

<table>
<thead>
<tr>
<th>Questions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do I want to change in the header of the email approval notification?</td>
<td>Add a word to the header.</td>
</tr>
<tr>
<td>Do I want to add fields or columns to or remove fields or columns from the email approval notification?</td>
<td>Add a field to the template.</td>
</tr>
</tbody>
</table>

You can modify an Expenses BI Publisher email approval notification by:

1. Exporting the Expense Approval Data Model
2. Downloading the Expense Report Approval template
3. Editing the Expense Report Approval template
4. Adding field and table attributes to the Expense Report Approval template
5. Previewing the modified Expense Report Approval template
6. Uploading the modified Expense Report Approval template

**Prerequisites**

Before you can modify an Expenses workflow email approval notification, complete these steps:

1. Download and install the Template Builder for Word, which is a BI Publisher add-on for Microsoft Word.
   a. Sign into the Oracle Business Intelligence Publisher server with the BI Administrator Role.
   b. On the Oracle Business Intelligence home page by the Get Started section, click the **Download BI Publisher Desktop Tools** link.
   c. Select and install **Template Builder for Word**.
2. Download a copy of the subtemplate, which is the FinFunWorkflowNotificationSub.rtf file, to your local drive.
   a. Click the Catalog menu.
b. In the BI Catalog, expand **Shared Folders > Common Content > Templates.**

c. Click the **Edit** link for Workflow Notification Subtemplate.

d. On the Workflow Notification Subtemplate - Sub Template page in the Templates section, click the language name link in the Locale column.

e. Save the FinFunWorkflowNotificationSub.rtf file to your local drive.

3. Create an expense report and note the expense report number. You enter the expense report number when you export the data model .xml file.

**Exporting the Expense Approval Data Model**

Before you can modify the Expense Report Approval template, you must export the .xml file that contains the predefined data model attributes for the notifications. Complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.

2. **Navigator > Tools > Reports and Analytics.**

3. On the Oracle BI Publisher home page, click the Catalog menu.

4. On the Catalog page in the Folders pane, expand **Shared Folders > Financials > Workflow Notifications.**

5. Expand the Expenses folder.

6. Click the Expenses subfolder to display the data models and the notification templates.

7. Click the **Data Models** link.

8. By Expense Approval Data Model, click the **Edit** link.

    The Diagram tab displays data sets for the Expense Approval Data Model.

9. Scroll to see all the data sets.

10. To ensure that all data sets include requested elements with null values in the output XML data, complete these steps:

    a. In the Data Model pane, click the **Properties** link.

    b. In the Properties section, select the **Include Empty Tags for Null Elements** check box.

11. In the Data Model pane, click the **Data Sets** link.

12. On the Expense Approval Data Model page, select the Data tab and scroll to locate the **Expense Report Number** field.

13. In the **Expense Report Number** field, enter the expense report number that you created in the third step of the Prerequisites section in this document.

14. Click **View** to see the sample data and all the available attributes.

15. Click **Save As Sample Data.**

16. Click **OK.**

17. Click **Export.**

18. Click **Save as** to save the Expense Approval Data Model .xml file to your local drive.

**Downloading the Expense Report Approval Template**

The Expense Report Approval template contains the structure of the email approval notification. To download a copy of the Expense Report Approval template to your local drive, complete these steps:

1. Click the Catalog menu.

2. On the Catalog page in the Folders pane, expand **Shared Folders > Financials > Workflow Notifications > Expenses.**

3. Click the Expenses subfolder to display data models and the notification templates.

4. By Expense Report Approval, click the **More** link, and select **Customize.**

   An image of the predefined Expense Report Approval Email Notification appears. A copy of the Expense Report Approval template is automatically created in the Custom folder. You can find the copy by expanding Shared Folders > Custom > Financials > Workflow Notifications > Expenses.

5. By the predefined Expense Report Approval Email Notification template, click the **Edit** link.
6. Click **Save as** to save the Expense Report Approval Email Notification template to your local drive as an .rtf file.

   **Tip:** Save the downloaded template with the name `UpdatedExpenseApprovalNotificationReport.rtf` to distinguish it from the predefined template.

### Editing the Expense Report Approval Template

To edit the header section of the Expense Report Approval Email Notification template, complete these steps:

1. Double click the `UpdatedExpenseApprovalNotificationReport.rtf` file you saved to your local drive.
2. In the header section, place your cursor between `Expense` and `Approval`.
   You can add, delete, or change words in the Expense Report Approval template.
4. Save and close the .rtf file.

### Adding Field and Table Attributes to the Expense Report Approval Template

To add field and table attributes to the Expense Report Approval template, complete these steps:

1. In Microsoft Word, open your local copy of the `UpdatedExpenseApprovalNotificationReport.rtf` file.

   **Note:** Depending on your version of Microsoft Word or your installation of Template Builder for Word, you may see either a BI Publisher tab or you may find BI Publisher by the Add-ins menu.

2. From the Add-ins menu, select **BI Publisher > Data > Load Sample XML Data**.
3. In the **Select XML data** dialog box, search for and select the Expense Approval Data Model .xml file you downloaded.
4. Click **Open**.
   A message displays that indicates your .xml data was successfully loaded.
5. Click **OK**.
6. To insert a field in the Expense Report Approval template, place your cursor at the end of the line you want to insert into, and press the Enter key on the keyboard.
7. From the Add-ins menu, select **BI Publisher > Insert > Field**.
8. In the **Field** dialog box, scroll to the EXPENSES folder, select `IMG_REQ_FLAG`, and click **Insert**.
   This step inserts text that indicates a receipt image is required. You can add fields from the data model anywhere in the Expense Report Approval .rtf template.
9. From the Add-ins menu, select **BI Publisher > Insert > Field**.
10. In the **Field** dialog box, scroll to the RECENTSIMILAREXPENSES folder, select any field that you want to insert, and click **Insert**.

   **Note:** You can also insert fields that are associated with the following folders: RecurringViolations, RecentSimilarExpenses, and UnappliedCashAdvances.

### Previewing the Modified Expense Report Approval Template

Before uploading your modified Expense Report Approval template to the BI Catalog, you can preview the changes you made. By previewing changes, you can avoid uploading a modified template that displays errors in the emails sent to users.

1. Open your local copy of the `UpdatedExpenseApprovalNotificationReport.rtf` file in Microsoft Word.
2. At the beginning of your modified .rtf template, save the path information for future reference so you can replace it after previewing. The path information may look like this: `<?import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>`
3. Replace the path at the beginning of your modified .rtf template with the location of the subtemplate that you downloaded as a prerequisite. For example, change `<?import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>`

*Note:* In the preceding example, part of the replacement path, C:/Template_Directory, represents the folder in which the user downloaded the subtemplate to in the second step of the Prerequisites section in this document. Ensure that you change all backward slashes to forward slashes.

4. From the Add-ins menu, select **BI Publisher > Preview > HTML**.
5. If the preview reflects your expected changes, then change the path at the beginning of your modified .rtf file back to the original path.
6. From the Add-ins menu, select **Validate Template**.
7. Save your changes in Microsoft Word.

**Uploading the Modified Expense Report Approval Template**

To upload and use the modified Expense Report Approval template for email approval notifications, complete these steps:

1. On the Oracle BI Publisher home page, click the Catalog menu.
2. On the Catalog page in the Folders pane, expand **Shared Folders > Financials > Workflow Notifications**.
3. Click the Expenses subfolder to display the data models and the notification templates.
4. By the Expense Report Approval, click **Edit**.
5. On the Expense Approval Report page, click **Add New Layout**.
6. In the Upload or Generate Layout section, click the **Upload** icon.
7. In the **Upload Template File** dialog box, **Layout Name** field, enter **UpdatedExpenseApprovalReportTemplate**. The entry represents the name of the Expense Report Approval Template .rtf file that you downloaded and saved to your local drive with the prefix Updated.
8. In the **Template File** field, browse for your modified UpdatedExpenseApprovalReportTemplate.rtf file on your local drive, select the template, and click **Open**.
9. In the **Upload Template File** dialog box from the **Type** choice list, select **RTF Template**.
10. From the **Locale** choice list, select **English (United States)**.
11. Click **Upload** to open the **Processing** dialog box and return to the Expense Approval Report page. The uploaded modified .rtf file appears.
12. On the Expense Approval Report page, click the **View a list** link.
13. In the Layout section in the row for the Updated Expense Report Approval Template, select the **Default Layout** check box. This step enables your modified Expense Report Approval Notification template to act as the default email approval notification.
14. Click the **Save Report** icon.

**Enable Expenses Configurable Email Notifications**

You can use workflow email approval notifications to submit approvals to approvers. These approval notifications are Oracle Business Intelligence (BI) Publisher-based approval notifications that are embedded in emails. If you want to change the content or appearance of your email approval notifications, you can modify the content or format of the Oracle BI Publisher templates.

Before you can use or modify workflow email approval notifications, you must enable in Setup and Maintenance any or all of the following sets with their corresponding notifications:

- Expense Report Approval Notifications
  - Expense report approval notification
• Expense Reimbursement Notifications
  o Expense report payment notification to employee (check)
  o Expense report payment notification to employee (direct deposit)
  o Payment to card issuer notification

• Expense Audit and Receipt Management Notifications
  o Expense report is rejected by auditor
  o Expense report is returned to employee
  o Expense report is short paid due to receipt issue
  o Expense report is adjusted
  o Expense report is short paid due to non-compliance issue
  o Pending payment with warnings

• Cash Advance Notifications
  o Cash advance approval notification

Enabling Configurable Email Notifications
To enable workflow email approval notifications, follow these steps:

1. Navigator > My Enterprise > Offerings.
2. In the Offerings work area, select Financials.
3. Click Opt In Features.
5. Click the Edit icon.
6. On the Edit Features: Expenses page, select Configurable Expenses Email Notifications.
7. Click the Edit icon.
8. In the Feature Name: Configurable Expense Email Notifications dialog box, select any or all of the notification sets.
9. Click Save and Close.

Configuring Payables Email Notifications: Explained
Payables has configurable email notifications that can meet your business needs and requirements. For example, approvers for Payables invoice approval receive a standardized email notification when the invoice requires their approval. This standardized email notification has a list of attributes shown in a specific format. However, you have your own requirements regarding what information is in the approval email notifications and in the format you want displayed. The ability to configure email notifications to meet your specific business needs and requirements is now available. The capability to configure the notifications supports changing the format, content, and display of the notifications. In the invoice email approval notification, you have the ability to add other invoices and related attributes that you or your customers want to display in those email notifications.

Payables Email Notifications
The current Payables email notifications are listed in the following table:
### Oracle Business Intelligence Publisher

Use Oracle Business Intelligence Publisher (BIP) for configuring the Payables email notifications.

- The notifications are optimized for mobile devices and are ready to use as delivered.
- The templates are ready to use as delivered. The templates can be easily configured to meet your business requirements. If required, you can change the delivered template layouts and content, to add images, change colors and styling, add or remove attributes or modify text.

Predefined BIP reports generate workflow email notifications pulling content from the standard data models. The report layouts use common table and paragraph styling. In addition, a common sub template is used for reusable notification components, including: a custom logo in the notification header, action buttons, and task history.

> **Note:** The history component is currently not based on a BIP data model and cannot be modified.

### Best Practices

The following are recommended best practices:

- Never edit seeded notifications.
- Use the Customize feature for reports and subtemplates.
- Copy the data models, paste into the Custom folder, and edit the copies.
- Do not rename the standard BI components, the reports or sub templates. Preview your changes before publishing. Revert customizations in case of issues.
- Do not modify any hyperlinks in the subtemplate file. Before saving a local copy, disable the Update links on the save option in Microsoft Word.

### Modifying Invoice Approval Email Notifications Using Oracle Business Intelligence (BI) Publisher: Worked Example

This example shows how to modify email notifications for the invoice approval workflow using BI Publisher reports.
The following table summarizes the key decisions for this scenario:

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This example</th>
</tr>
</thead>
<tbody>
<tr>
<td>What text changes are needed in the header section of the notifications?</td>
<td>Add custom text to the notification to give instructions to the approvers.</td>
</tr>
<tr>
<td>What additional fields should the header section of the notification contain?</td>
<td>Add an additional attribute for displaying Payment Terms for the invoice.</td>
</tr>
</tbody>
</table>

**Prerequisites**

Download and install the Template Builder for Word, which is an extension to Microsoft Word.

1. In the Reports and Analytics work area, click the Browse Catalog button.
2. Click the Home link.
3. In the Get Started section, click the Download BI Desktop Tools link.
4. Select Template Builder for Word from the list.
5. Save the file and run the installer.

**Modifying Invoice Approval Email Notification**

To add the custom instructions text to the header section of the notification, we need to modify the common subtemplate used for the notifications.

To edit a copy of the predefined subtemplate that contains the shared components:

1. Click on Navigator > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), expand Shared Folders > Common Content > Templates.
4. For Workflow Notification Subtemplate, click More and select Customize.
   If you’re not using the Customize option:
   a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
   b. In the BI catalog, expand Shared Folders > Custom > Common Content Templates. Create a Templates folder in this location if it doesn’t exist.
   c. Click Paste in the toolbar.
   d. Click the Edit link for the copied subtemplate.

   **Note:** All reports using the predefined subtemplate are automatically redirected to point to your subtemplate in the Custom folder. This applies:
   o To all reports, predefined or not.
   o No matter if you copy and paste the subtemplate or use the Customize option.
   o Only if your subtemplate has the same name and relative file path in Custom as the predefined subtemplate

5. In the Templates section, click the link in the Locale column.
6. Save the subtemplate .rtf file to your computer.
7. Open the .rtf file with Microsoft Word.
   o To add custom instructions text, add a new section with the following details:
     • `<template:InstructionText?>`
All invoices must be approved within 2 working days. In case of any queries, kindly write to approval.support@vision.com.

   <?end template?>

\textbf{Note:} To ensure that your layout templates reflect these changes without additional rework, don’t edit any other text in the subtemplate .rtf file.

8. Update Word options to ensure that existing links remain intact in the subtemplate
   o Click File > Options > Advanced.
   o In the Word Options dialog box, click Web Options in the General section.
   o In the Web Options dialog box, open the Files tab.
   o Deselect the Update links on save check box.

\textbf{Note:} The exact steps can vary depending on your version of Microsoft Word.

9. Save your changes in Word.

\textbf{Uploading the Modified Subtemplate}

To upload your subtemplate to the BI catalog after previewing the changes:

1. In the BI catalog, expand Shared FoldersCustomCommon Content Templates..
2. Click Edit for Workflow Notification Subtemplate.
3. In the Templates section, click the Upload icon.
4. Select your modified .rtf subtemplate and a locale, and click OK to overwrite the original subtemplate.

Next we will make changes to the Invoice Approval Email Notification report layout to reflect the updates in the shared component, as well as add the new attribute to the report layout. To do this, we need to modify the Invoice Approval Email Notification report layout.

\textbf{Downloading the Report Layout Template}

The report layout template contains the structure of the email notification. To download a copy of the report layout template to your local drive for modification:

1. Sign in to the BI server (for example, http://hostname.com:7001/xmlpserver) as an Application Implementation Consultant to open the Oracle Business Intelligence home page.
2. Click the Catalog link to open the Catalog page.
3. In the Folders pane, expand the Shared Folders>Financials>Workflow Notifications> Payables folder.
4. Click the Invoices folder to display the Data Models subfolder and the Invoice Approval Report.
5. Click the More link for the Invoice Approval Report, and then select Customize from the menu. The Invoice Approval Email Notification report layout template is automatically copied to the Custom folder. The Invoice Approval Report page opens from within the Custom folder.
6. Click the Edit link on the copy of the Invoice Approval Email Notification report layout.
7. Save the copy of the .rtf file to your local drive and change the file name to distinguish it from the predefined report layout template. For example, save the file as UpdatedInvoiceApprovalNotificationReport.rtf.

\textbf{Note:} Be sure to change the name of the .rtf file, otherwise you could overwrite the predefined report layout template.
Exporting the Data Model
To add attributes to the report layout template, you must first export the data model for the report.

1. Navigate back to the Oracle Business Intelligence home page, and click the Catalog link.
2. On the Catalog page, in the Folders section, expand Shared Folders>Financials>Workflow Notifications>Payables>Invoices.
3. Click the Data Models folder to display the Invoice Approval Data Model.
4. Click the Edit link for the Invoice Approval Data Model. The Invoice Approval Data Model page opens on the Diagram tab.
5. Click the Data tab. To export the full data model, you must first enter valid values for Business Unit, Supplier and Invoice Number attributes from an existing Invoice.
6. Click in each of these fields and enter valid values from an existing Invoice approval notification:
7. To include empty attributes in the data model export, click the Properties link in the Data Model section.
8. On the Properties page, select the Include Empty Tags for Null Elements option.
9. In the Data Model section, click the Data Sets link to return to the Data tab.
10. Click the View button to view the data model.
11. Click the Export button and save the Invoice Approval Data Model_.xml file to your local drive.

Modifying the Invoice Approval Email Notification Report Layout
To add a reference to the update in the subtemplate for the Instruction text that we want to add to the Invoice Approval Email Notification:

1. Open your local copy of the report layout template using Microsoft Word.
2. Replace the path with the location of the modified subtemplate file on your computer. For example, change <?import:xdoxsl:///CommonContent/Templates/Workflow Notification Subtemplate.xsb?> to <?import:file:C://Template_Directory/Updated Workflow Notification Subtemplate.ret?...
3. Place your cursor at the end of the default header text for Invoice Approval.
4. Add a space and enter the following: <?call-template:InstructionText?>. By doing this, the custom instruction text will be retrieved from the updated subtemplate and displayed in the email notification.
5. Save the file.
6. From the BI Publisher tab in the Ribbon, click HTML in the Preview group. If the preview reflects your subtemplate changes as expected, then change the subtemplate path back to the location in the Custom folder, for example: <?import:xdoxsl:///Custom/Templates/Workflow Notifications Subtemplate.xbs?>.
7. If you’re not adding attributes to the report layout, close the file and skip to the Uploading the Modified Report Layout task.

To add an attribute for Payment Terms in the header section of the report layout:

a. In your local copy of the report layout, select the BI Publisher tab.
b. In the Load Data section on the BI Publisher ribbon, click Sample XML.
c. On the XML data selection dialog box, select the .xml file that you saved in step 11 of ‘Exporting the data model’ and click Open.
d. Click OK on the message that appears indicating that the data was successfully loaded.
e. Place your cursor in the Details section of the notification. Add an additional row after the Description attribute.
f. In the Attribute column, enter a label for the new attribute. In this case, enter Payment Terms.
g. Then place the cursor in the Value column and go to the BI publisher add-in. Navigate to Insert > Field and search for Payment Terms in the search field.
h. Select the Payment Terms attribute and click Insert.
i. Save and close your copy of the report layout.

**Uploading the Modified Report Layout Template**

To use the modified report layout template for future Invoice approval email notifications:

1. Navigate back to the Oracle Business Intelligence home page and click the Catalog link.
2. On the Catalog page, in the Folders section, expand Shared FoldersCustomFinancials Workflow NotificationsPayables.
3. Select the Invoices folder to display the Data Models folder and the Invoice approval report.
4. Click the Edit link for the Invoice Approval Report to open the Invoice Approval Report page.
5. Click the View a list link to open the Layout page.

   **Note:** The Layout page displays the copy of the report layout template that was automatically created in step 5 of the Downloading the Report Layout Template task. Leave this report layout template as is. If the modified email notifications don’t work, you can revert back to using this report layout template, which is a copy of the predefined report layout template.

6. Click the Create icon. A page opens with a Create Layout section and an Upload or Generate Layout section.
7. In the Upload or Generate Layout section, click the Upload icon. The Upload Template File dialog box opens.

   Complete with the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout Name</td>
<td>Enter a name for your modified report layout template. For example, enter Modified Invoice Approval Template.</td>
</tr>
<tr>
<td>Template File</td>
<td>Click Browse. Locate and select the modified report layout template that’s on your local drive. Click Open to return to the Upload Template File dialog box.</td>
</tr>
<tr>
<td>Type</td>
<td>RTF Template</td>
</tr>
<tr>
<td>Locale</td>
<td>English</td>
</tr>
</tbody>
</table>

8. Click Upload. The Invoice Approval Report page returns to the thumbnail view of the report layout templates.
9. Click the View a list link to return to the Layout page with the list of the report layout templates.
10. Select the row with the report layout template that you just uploaded and click the View Report button.
11. Review the modified report layout template.
12. To view the report layout template with sample data, enter values from an existing notification into the fields and click Apply.
13. Repeat steps 1 through 5 to navigate back to the list of report layout templates. In the row for the report layout template that you just uploaded, click the Default Layout option. This step enables the modified report layout template for future Invoice approval email notifications.
14. Click the Save icon.
5 General Ledger Reports

Considerations for Implementing Financial Reporting Center

The Financial Reporting Center adds self-service functionality for the Oracle Fusion Applications and the Oracle Fusion Accounting Hub. The financial reports are available immediately on both computers and mobile devices, which leads to quicker decision making.

Note: To access the reports in Financial Reporting Center, store the reports in the My Folder or Shared Custom directories.

Job Roles and Duty Roles
The following table shows the predefined job roles and their associated duty roles.

<table>
<thead>
<tr>
<th>Predefined Job Role</th>
<th>Duty Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Accountant</td>
<td>• Financial Reporting Management</td>
</tr>
<tr>
<td></td>
<td>• Account Balances Review</td>
</tr>
<tr>
<td>General Accounting Manager</td>
<td>• Financial Reporting Management</td>
</tr>
<tr>
<td></td>
<td>• Account Balances Review</td>
</tr>
<tr>
<td>Financial Analyst</td>
<td>• Financial Reporting Management</td>
</tr>
<tr>
<td></td>
<td>• Account Balances Review</td>
</tr>
</tbody>
</table>

Business Process Model Information
The features are part of the Manage Financial Reporting and Analysis detailed business process. The following table shows the activities and tasks for that business process.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare Financial Reports</td>
<td>Generate Financial Statements</td>
</tr>
<tr>
<td>Analyze Financial Performance</td>
<td>Inquire and Analyze Balances</td>
</tr>
</tbody>
</table>
Set Up Financial Reporting Center and Smart View

Oracle Fusion Financial Reporting Center is a powerful tool for reviewing, designing, and presenting financial reports and analytic data. The critical choices required to configure and install the components in Financial Reporting Center consist of:

- Configuring the Financial Reporting Center
- Installing and configuring Financial Reporting Studio, performed by your end users
- Installing Smart View, performed by your end users
- Configuring Workspace Database Connection, performed by your administrator

Configuring Financial Reporting Center

You have access to the reports in the Financial Reporting Center and Workspace installed with Oracle Fusion Financial Applications. Your Oracle Fusion Business Intelligence (BI) administrator defines the folder structure in Workspace. The administrator considers your company’s security requirements for folders and reports, as well as report distribution requirements for financial reporting batches.

- Security can be set on folders and reports from Workspace.
- You are granted access to the folders and reports you want to view by your BI administrator.

Installing and Configuring Financial Reporting Studio

Oracle Financial Reporting Studio is client-based software. If you open Oracle Fusion Applications from Oracle Cloud, you connect to the Financial Reporting Studio through a Windows Remote Desktop Connection. Report authors download installation files for Financial Reporting Studio from Workspace by clicking **Navigator** > **Financial Reporting Center** > **Tasks** panel drawer > **Open Workspace for Financial Reporting**. Once Workspace is started, click **Tools** > **Install** > **Financial Reporting Studio**. After performing the prerequisites and completing the installation, start the Financial Reporting Studio. Provide your user ID, password, and the **Server URL**. Derive the **Server URL** information by following the steps:

1. Open **Navigator** > **Financial Reporting Center** > **Tasks** panel drawer > **Open Workspace for Financial Reporting**.
2. Edit the **Workspace URL** and remove workspace/index.jsp.
3. Following are two examples of **Server URLs**:
   - If the **Workspace URL** is https://fusionsystemtest-p-external-bi.visioncorporation.com/workspace/index.jsp, the **Server URL** is https://fusionsystemtest-p-external-bi.visioncorporation.com.
   - If the **Workspace URL** is https://fusionsystemtest-p-external-bi.visioncorporation.com:10622/workspace/index.jsp, the **Server URL** is https://fusionsystemtest-p-external-bi.visioncorporation.com:10622.
4. Copy the modified URL to the **Server URL** field.

**Note:** For end users installing the Oracle Fusion Financials Reporting Studio, the installer starts a separate console window. The installer continues to run for a brief time after the installation completes the setup tasks. The process is normal, expected, and applies to Oracle Reporting Studio installations in both the Oracle Fusion Applications and Enterprise Performance Manager modes. Wait for the console window to close, which happens automatically, before clicking the **Finish** button on the Financial Reporting Studio Installation dialog box. If you click the **Finish** button before the console window closes, the Financial Reporting Studio installation may not complete.
Prerequisites needed for installing the Financial Reporting Studio are:

2. Microsoft Office installed on your users’ computers.

Installing Smart View

Smart View is an Excel add-in that must be loaded on each client. To download Smart View, click **Navigator** > **Financial Reporting Center** > **Tasks** panel drawer > **Open Workspace for Financial Reports**. Once the workspace is started, click **Tools** > **Install** > **Smart View**.

**Note:** Since Smart View is an add-in to Microsoft Office products, you can install Smart View only on a Windows operating system.

Once Smart View is installed, you must configure the connection using the Smart View Shared Connections URL. You can derive the Shared Connections URL by following these steps:

1. From the Financial Reporting Center task panel, select **Open Workspace for Financial Reporting**.
2. Edit the workspace URL by removing `index.jsp` and adding `SmartViewProviders` at the end.

**Note:** The following URL is an example for a Cloud-based environment. If the workspace URL is `https://efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/index.jsp`, the Shared Connections URL is `https://efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/SmartViewProviders`.

3. Copy the URL.
4. Open Excel.
5. From the Smart View menu, click **Options** > **Advanced**.
6. Paste the URL in the **Shared Connections URL** field.
7. Click **OK**.

To connect Oracle Fusion General Ledger Balances cubes in Smart View:

1. Open Smart View from your **Start menu** > **Programs** > **Microsoft Office** > **Microsoft Excel 2007**.
2. Navigate to the **Smart View** menu > **Open**. On the **Start** on the ribbon, click **Smart View Panel** that appears in the list of values from the ribbon. The task pane opens.
3. Click **Shared Connections** on the task pane.
4. Sign in with your user name and password.
5. Click the **Select Server to proceed** list of values.

**Note:** If the Essbase Server is not there, then it has to be added. Use the following steps:

a. Click the Add Essbase Server link.

b. Specify the Essbase Server login and password.

c. Expand the Essbase server and locate the cube in it.

6. Select **Oracle Essbase** from the list of shared connections.
7. Click the **Expand** to expand the list of cubes.
8. Expand your cube (name of your chart of accounts).
9. Click **db**.
10. Click the analysis link.

Nota: You must perform these steps only once for a new server and database.

To set how the name and alias of the Essbase database appears:

1. Click Options on the ribbon > select the Member Options > select Member Name Display.
2. Set one of these three options:
   - Distinct Member Name. Only shows the full Essbase distinct path.
   - Member Name and Alias: Shows both the member name and the alias.
   - Member Name Only. Shows only the member name.

Nota: The Smart Slice feature is not supported in Oracle Fusion General Ledger. For all other documentation, refer to the Oracle Smart View for Office User's Guide.

Configuring Workspace Database Connections

Administrators must create database connections from Workspace so users can access the cubes from Workspace and Financial Reporting Studio.

Nota: Ledger setup has to be completed before the database connection can be created. Oracle Fusion General Ledger balances cubes are created as part of ledger setup. A separate cube is created for each combination of chart of accounts and accounting calendar. A database connection is needed for each cube.

Steps to define a database connection are:

1. Start at the Navigator by selecting Financial Reporting Center.
2. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.
3. From within Workspace select the Navigator menu > Applications > BI Catalog.
4. Select Tools menu > Database Connection Manager.
5. Select New button.
6. Enter a user-friendly name for the Database Connection Name.
7. Enter Essbase as the Type, your server, user name, and password.
8. Select Application (cube) and Database from the list of values. Expand the Application name to see the related Database.
9. Click the OK button twice to save your selections.
10. Click Close button in the Database Connection Manager window to save your connection.

Nota: The database connection is available in both Workspace and Financial Reporting Studio. Optionally, it can be set up in Financial Reporting Studio when putting grids on a report. This should only be done by an administrator.

For more detailed information about Smart View and Financial Reporting Studio, refer to the Using EPM with Oracle Financials Cloud link on the Books for Oracle Financials Cloud page of the Oracle Help Center at https://docs.oracle.com.

Smart View
Overview of Smart View

Oracle Hyperion Smart View provides common Word, PowerPoint, and Excel interfaces designed specifically for Oracle Hyperion Enterprise Performance Management, Oracle Business Intelligence Enterprise Edition, and Oracle Fusion General Ledger. Using Smart View, you can view, import, manipulate, distribute, and share data in Excel, Word, and PowerPoint interfaces. Smart View is a comprehensive tool for accessing and integrating Enterprise Performance Management, Business Intelligence, and General Ledger content from Microsoft Office products.

Smart View provides the ability to create and refresh spreadsheets to use real-time account balances and activity. You can use Smart View for:

- Analysis
- Predefined form interaction
- Report design

Analysis

Smart View uses the Excel environment to interactively investigate the data contained in the sources. You start with templates that begin the process or a blank sheet where you begin shaping and altering the grids of data.

Predefined Form Interaction

As an Oracle Fusion user who executes predefined inputs or reporting forms, Smart View a convenient way of completing tasks within Microsoft Office. Use Smart View to work in the Excel environment either for consistent experience or to tie other spreadsheet-based models into your process. For example, use Smart View with Oracle Hyperion Planning to incorporate data that is still housed in spreadsheet and workbook-based models.

Report Design

Report design is another dimension of Smart View, which leverages the capabilities of Oracle Fusion General Ledger data. Once the data is available within Smart View you can create reports as needed based on a combination of data sources. For example, planning and financial management data can be used to compare actual to budget. Reports can be made more complex by providing the ability to compare multiple scenarios for different periods. The power of Smart View is used to create reports and is refreshed periodically, as needed.

Smart View provides the ability to create and refresh spreadsheets to use real-time account balance information. You can use Smart View to:

- Perform ad hoc multidimensional pivot analysis with full spreadsheet functionality
- Drill down from any parent value to the next parent or child value
- Perform drill down from any child value to detail balances, journal lines, and subledger transactions
- Analyze actual, budget, and forecast information
- Increase visibility with charts and graphs
- Apply date effective hierarchies to past, present, or future hierarchies to change the financial data reported in your financial reports. For example, to compare 2014 to 2015 results, realign the data in your 2014 reports by applying the 2015 organization hierarchy.

**Tip:** Best practice when using Smart View is to always turn on row suppression in the Smart View options. You can’t suppress columns in Smart View. For more information about Smart View suppression, see the Smart View Options chapter in the Oracle Smart View for Office User’s Guide at http://docs.oracle.com/cloud/latest/epm-common/SVPBC/opt_data.htm#SVPBC-options_202.
Creating an Ad Hoc Analysis in Smart View

This example shows how to create an ad hoc analysis in Smart View.

Creating an Ad Hoc Analysis

This example includes steps for configuring the Smart View connection, selecting dimension members, creating separate reports, and formatting amounts.

1. Navigate to the Financial Reporting Center.
2. Open the Tasks panel and click the Open Workspace for Financial Reports task.
3. Remove /index.jsp from the end of the workspace URL and copy the rest of the URL. For example, copy https://adc-fapXXXX-bi.oracledemos.com, where XXXX is the unique instance ID.
4. Open Excel.
5. Navigate to the Smart View ribbon and click Options.
6. In the Shared Connections URL field on the Advanced tab, replace everything before workspace with the copied URL. For example, https://adc-fapXXXX-bi.oracledemos.com/workspace/SmartViewProviders
7. Click OK.
8. On the Smart View ribbon, click Panel. The Smart View panel opens.
9. On the Smart View panel, click Shared Connections.
10. Sign in with your user name and password.
11. On the Smart View panel, select the drop-down list for the Select Server to proceed field.
12. Select Oracle@Essbase from the list of shared connections.
13. Expand the list of cubes for Essbase_FA_Cluster.
14. Expand the USChartofAccounts cube.
15. Select db. Don't expand the selection.
16. On the Smart View panel, click Connect, and then click Ad hoc analysis.
17. On the Essbase ribbon, click POV. The Point of View window enables you to select data dimension values, so you can pinpoint the information you want for the Excel analysis.
18. On the Point of View window, click the drop-down list for each dimension and select the ellipsis (…) to open the member selector. On the Member Selection window, remove the default selection for each dimension using the Remove icon. Select the dimension value and add it using the Add icon. Click OK. Complete the member selection, as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>[All Company Values],[101]</td>
</tr>
<tr>
<td>Line of Business</td>
<td>10</td>
</tr>
<tr>
<td>Account</td>
<td>11200-Cash</td>
</tr>
<tr>
<td>Cost Center</td>
<td>All Cost Center Values</td>
</tr>
<tr>
<td>Product</td>
<td>All Product Values</td>
</tr>
<tr>
<td>Intercompany</td>
<td>All Intercompany Values</td>
</tr>
</tbody>
</table>
### Field | Value
---|---
Scenario | Actual
Balance Amount | Period Activity
Amount Type | Period-to-date
Currency | USD
Currency Type | Total

19. On the worksheet, click the **Accounting Period** dimension in row 3, column A.
20. Right-click and select **Smart View, Member Selection**.
21. On the **Member Selection** window, remove the default selection. Expand the **Accounting Period** dimension and add the period 12-16.
22. Click **OK**.
23. Double-click **Ledger** in row 2, column B, to zoom in. You can also zoom in by selecting the dimension, navigating to the **Essbase** ribbon, and clicking **Zoom In**.
24. Click **All Ledgers** in row 2, column B, and click **Zoom Out** on the Essbase ribbon.
25. Right-click **Ledger** in row 2, column B, and select **Smart View, Member Selection**.
26. On the **Member Selection** window, remove the default selection of **Ledger**.
27. Select **US Ledger Set** and click the **Add** icon.
28. Click **OK**.
29. On the **Point of View** window, click **Refresh**.
30. Double-click **US Ledger Set** in row 2, column B, to zoom in.
31. Click the **[US Ledger Set],[US Primary Ledger]** cell.
32. On the **Essbase** ribbon, click **Keep Only** to remove the other Ledger members and keep only the selected member.
33. To create a separate report based on the Company dimension, on the **Essbase** ribbon, click **Cascade** and select **Same Workbook**. The **Member Selection** window opens.
34. On the **Member Selection** window, select [**All Company Values],[102**] and click the **Add** icon.
35. Click **OK**. A worksheet opens for company 102.
36. Click the **All Company Values.101** worksheet.
37. Click the amount cell in row 3, column B.
38. Navigate to the **Home** ribbon and set the **Accounting Number Format** option to the dollar sign.
39. Navigate to the **Essbase** ribbon and click **Preserve Format**.
40. On the **Point of View** window, click **Refresh**.

---

**Define a Report in Smart View with the Query Designer**

This example shows how to define a report using the Query Designer in Smart View.

**Defining a Report with the Query Designer**

1. Open Excel and navigate to the **Smart View** ribbon. Click **Panel**.
2. Click **Shared Connections**.
3. Sign in with your user name and password.
4. Click the **Select Server to proceed** drop-down list.
5. Select Oracle Essbase.
7. Highlight db. Don’t expand db.
8. Click Connect.
9. Click the analysis link.
10. Navigate to the Essbase ribbon and click Point of View.
11. In the spreadsheet, click cell A2.
12. On the Essbase ribbon, click Query and select Query Designer. A new sheet named, Sheet1-Query is created and the Query Designer displays.
13. On the Point of View panel, move:
   a. Account to the Rows section.
   b. Accounting Period to the Columns section.
   c. Ledger to the Point of View section.
   d. Company to the Rows section, as the first dimension.

   ♦ Note: You can also select the dimensions cells on the worksheet and use the Pivot command on the Essbase ribbon to perform these steps.

14. Open the Amount Type dimension by clicking the drop-down list and selecting the Member Selection link. Remove the default placeholder using the Remove icon. Select the period-to-date value and add it to the panel of selected values using the Add icon.
15. On the Member Selection window, click the drop-down list next to the Amount Type dimension to toggle to each Point of View dimension. Complete the fields, as shown in this table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ledger</td>
<td>US Ledger Set &gt; [US Ledger Set].[Us Primary Ledger]</td>
</tr>
<tr>
<td>Line of Business</td>
<td>All Line of Business Values</td>
</tr>
<tr>
<td>Cost Center</td>
<td>All Cost Center Values</td>
</tr>
<tr>
<td>Product</td>
<td>All Product Values</td>
</tr>
<tr>
<td>Intercompany</td>
<td>All Intercompany Values</td>
</tr>
<tr>
<td>Scenario</td>
<td>Actual</td>
</tr>
<tr>
<td>Balance Amount</td>
<td>Period Activity</td>
</tr>
<tr>
<td>Currency</td>
<td>USD</td>
</tr>
<tr>
<td>Currency Type</td>
<td>Total</td>
</tr>
</tbody>
</table>

16. From the POV Sheet1-Query_1 panel, click AccountingPeriod to open the Member Selection window. You can also open the Member Selection window from the worksheet by right-clicking the AccountingPeriod cell, and selecting Smart View, Member Selection.
17. Remove the default selection. Expand 2016. Select all four quarters and add the quarters to the selected panel.
18. Click OK.
19. Click the **Company** dimension.
20. Expand **All Company Values**.
21. Select **[All Company Values][101]** and **[Company][941]** and add them. Remove the default value.
22. Click **OK**.
23. On the **POV Sheet1-Query_1** panel, click **Account** in the **Rows** section.
24. Expand **All Corporate Accounts-V1 > Account[@T] > 95001 - Net Income Current Year**.
25. Expand **95011-Revenue** and **95021-Expenses**.
26. Remove the default value. Select the following values and add them to the selected panel:
   - **95011-Revenue**
   - **40000-Revenues**
   - **95021-Expenses**
   - **50000-Material and Goods**
   - **60000-Operating Expenses**
   - **70000-Extra Charges and Tax**
27. Click **OK**.
28. On the **POV Sheet1-Query_1** panel, click **Apply Query**.
29. Save your report to the desktop as **your initials Smart View Financial Report**.
30. Insert 7 rows at the beginning of the spreadsheet.
31. Click in cell **A3**. Click the **Insert** tab and select **Picture**.
32. Select **WINNT (D) > Labs > Fin_reporting > Vision Logo**.
33. Click **Refresh**.

**Note:** You must refresh periodically to maintain the connection to the database.

34. From the **Insert** tab, click **Text Box**.
35. Click cell **C4** and type **your initials Income Statement for Companies 101 and 941**. Use excel formatting to format the text however you want.
36. Click **Refresh**.
37. Click **Save**.
38. Highlight all the cells that contain amounts.
39. Navigate to the **Home** ribbon, and from the **Number** section, select **dollar sign**.
40. On the **Home** ribbon, in the **Cells** section, select **Format > AutoFit Column Width**.
41. Navigate to the **Essbase** ribbon and select **Preserve Format**.
42. Click **Refresh**.
43. Click **Save**.
44. Insert three rows between the data for company 101 and 941.
45. On the first new blank row in Column B, type Total Income.
46. Add the following formula for the first column with data Qtr1-14: =C10+C15 where C10 is 95001-Revenue and C15 is 95021-Expenses.
47. Copy and paste that formula to the other columns.
48. Do the same formula for totals of Company 941.
49. Format all the total cells as **Accounting**. On the **Essbase** ribbon, select **Preserve Format**.
50. Click **Save**.
51. Insert 10 more rows between the data for Company 101 and 941.
52. Highlight all four rows of the expense data for all four quarters, including **Material and Goods**.
53. Navigate to the **Insert** ribbon and select the **Line chart** from the **Chart** section.
54. Select the first **2-D Line** chart layout.
55. On the line chart, click the Legend that reads Series1, Series2, Series3, and Series4.
56. From the **Chart Tools** ribbon, select **Select Data**.
57. In the **Legend Entries (Series)** pane, select Series2 and click **Remove**. Series2 is a total of expenses and not appropriate for this chart.
58. In the **Legend Entries (Series)** pane, select each series individually and click **Edit**. Complete the series and names fields, as shown in this table.

<table>
<thead>
<tr>
<th>Series</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series1</td>
<td>Material and Goods</td>
</tr>
<tr>
<td>Series3</td>
<td>Operating Expenses</td>
</tr>
<tr>
<td>Series4</td>
<td>Extra Charges and Tax</td>
</tr>
</tbody>
</table>

59. In the **Horizontal (Category) Axis Labels** panel click the first one and click **Edit**.
60. Click the icon next to the **Axis label range**: field.
61. On the spreadsheet, highlight the four quarter headers and click the icon next to the **Axis Labels** field.
62. Click **OK** twice.
63. Move and resize the line chart to fit inside the blank lines.
64. Click **Save**.
65. Navigate to: **Financial Reporting Center > Tasks** panel tab > **Open Workspace for Financial Reports**.
66. Click **Navigate > Applications > BI Catalog**.
67. Expand **Shared Folders > Custom > highlight Financial Reports**.
68. From the **Tasks** panel, select **Upload**.
69. Click **Browse and from your Desktop, select your Smart View Financial Report**.
70. Click **Open**.
71. Click **OK**.
72. Close the **EPM Workspace** tab.
73. From the **Financial Reporting Center**, click the **Search** icon.
74. Enter Smart and click **Search**.

笔记: Your report may not be found immediately. Wait a few minutes and try again.

### Create Financial Reports

#### Video: Defining a Report

**Watch:** This video tutorial shows you how to create a financial report to analyze and report results of business transactions. The content of this video is also covered in text topics.

#### Video: Adding a Formula

**Watch:** This video tutorial shows you how to add formulas to a financial report to calculate balances from business transactions. The content of this video is also covered in text topics.
Video: Defining a Range Function

Watch: This video tutorial shows you how to create range functions in a financial report to span several accounting periods. The content of this video is also covered in text topics.

Video: Defining the Grid Point of View

Watch: This video tutorial shows you how to define grid points of view in a financial report to reduce user input at report run time. The content of this video is also covered in text topics.

Video: Setting Page and Grid Properties

Watch: This video tutorial shows you how to define the page, row, and column attributes in a financial report. The content of this video is also covered in text topics.

Video: Formatting and Adding a Graph

Watch: This video tutorial shows you how to format and add graphs to a financial report to improve analysis of the data. The content of this video is also covered in text topics.

Procedure

In Oracle Hyperion Financial Reporting Studio, you can design traditional financial report formats such as balance sheets, profit and loss statements, and cash flow reports. You can also design nontraditional reports for financial or analytic data that include text and graphics. Use Financial Reporting Studio, a client-based application launched from your desktop, to create your reports.

Perform the following tasks to define a basic income statement.

1. Open Financial Reporting Studio on your desktop and sign in with your user name, password, and server URL.

Tip: The first time you sign in, copy the Financial Reports Workspace URL into the Server URL field and remove workspace/index.jsp from the end of the URL.
The following figure shows an example of the Financial Reporting Studio sign-in window, with the user name, password, and server URL fields populated.


3. On the Designer toolbar, click the **Insert Grid** icon. Grids are tables that contain data from external database connections.

4. Drag to select the area for the grid. The Select a Database Connection window opens.

   **Tip:** When creating a grid, best practice is to leave space in the designer area for other objects, such as a company logo and report title.

5. On the Select a Database Connection window, click the **Database Connection** list and select your database. A unique cube exists for each combination of chart of accounts and accounting calendar.
The following figure shows an example of the Select a Database Connection window, with the connection, user name, and password fields populated.

![Select a Database Connection window](image)

**Tip:** Best practice is to always turn on suppression in financial reports. This should be done at the Database Connection Server level. You can verify the setting by doing the following: highlight the grid, and from the menu, select **Task > Data Query Optimization Settings**. The normal best practice for most reports is to turn suppression on for the entire grid, and then turn suppression off for certain columns and rows that must always display. For more information about suppression settings, refer to the Using the Basic Option in Conditional Suppression section in the Designing with Financial Reporting Studio for Oracle Planning and Budgeting Cloud guide at [http://docs.oracle.com/cloud/latest/epm-common/CSFSU/ch09s04s02.html#BEGIN](http://docs.oracle.com/cloud/latest/epm-common/CSFSU/ch09s04s02.html#BEGIN).

6. Click **OK**. The Dimension Layout window opens.

### Arrange Dimensions and Define Rows

Use the Dimension Layout window to arrange the dimensions on the report. Use the Select Members window to select the revenue and expense accounts to include on the report.

1. On the Dimension Layout window, drag the dimensions from the Point of View frame as follows:
   a. **Accounting Period** dimension to the Columns frame.
   b. **Account** dimension to the Rows frame.
   c. **Company** dimension to the Pages frame.
The following figure shows the Dimension Layout window. The **Company** dimension is in the Pages frame, the **Accounting Period** dimension is in the Columns frame, and the **Account** dimension is in the Rows frame.

2. Click **OK**. The Dimension Layout window closes. The grid is inserted with the specified layout.

3. Select the revenues account.
   
   a. Double-click the **Account** cell on the grid. The Select Members window opens.
   
   b. Click the **Remove All** icon to deselect the default account member.
   
   c. In the Available area, expand the Account member, and continue expanding until you reach the revenue account for the report. You can also use the search to find your account.
   
   d. Select the account and click the **Add** icon to move the account to the Selected area.
The following figure shows the Select Members window for the Account dimension. The Account member is expanded and the revenues account for the report, which is 40000, appears in the Selected area of the window.

4. Click OK. The Select Members window closes.
5. Save the report.
   a. From the File menu, select Save As.
   b. Select the My Folders directory and enter a report name.
   c. Click Save.
6. Insert a blank row to add space between the revenue and expense accounts.
   a. Select the row after the revenues account and right-click the row header.
   b. From the Insert Row menu, select Text.
7. Insert a row for the expense accounts.
   a. Select the row after the new blank row and right-click the row header.
   b. From the Insert Row menu, select Data. The default value for the new row contains the revenue account.
8. Select the expense accounts.
   a. Double-click the new expense account cell in row 3. The Select Members window opens.
   b. Click the Remove All icon to deselect the default revenues account.
   c. In the Available area, expand the Account member, and continue expanding until you reach the expense accounts.
   d. Select the accounts and click the Add icon to move the accounts to the Selected area.
   e. Select the Place selections into separate rows option to create a separate row in the grid for each account.
The following figure shows the Select Members window for the Account dimension. The Account member is expanded and the expense accounts for the report appear in the Selected area of the window. The selected accounts are 50000, 60000, and 70000. The option called Place selections into separate rows is selected.

9. Click OK. The grid now includes the expense accounts.
10. Save the report and leave it open for the next activity.
11. You can preview the report in HTML or PDF format using the File menu or toolbar.

Add a Formula

Define a formula to summarize the expense account balances.

1. Select the row after the last expense account row and right-click the row header.
2. From the Insert Row menu, select Formula.
3. Click in the empty cell in the new row. The cell properties sheet opens.
4. On the cell properties sheet, select the Custom Heading option and enter Total Expenses.
5. Select the row header for the formula row, which in this example is row 6.
6. In the Formula bar, click the Sum(0) button to enter the formula into the formula text box.
7. Enter the cell references for the expense accounts into the formula, between the parentheses. In this example, the completed formula is Sum([3], [4], [5]).
The following figure shows the Financial Reporting Studio window with the formula entered in the formula text box.

![Financial Reporting Studio Window](image)

8. Validate the formula syntax by clicking the check mark icon in the toolbar. Validation checks the validity of the formula, not if data is available.

The following figure shows an example of the grid with the revenue account in row 1, expense accounts in rows 3 through 5, and total expenses in row 6.

![Grid Example](image)

9. Save the report and leave it open for the next activity. Optionally preview the report.

**Define a Range Function**

Use the range function to report across periods and create rolling period columns on the report.

1. Double-click the **Accounting Period** cell. The Select Members window opens.
2. Click the **Remove All** icon to deselect the default accounting period member.
3. Click the Functions tab.
4. Click the **Range** list item.
5. Click the **Add** icon to move the **Range** list item to the Selected area. The Edit Range Function window opens.
   a. Click in the **Value** field on the **Start Member** row.
   b. Click the **Lookup** icon. The Edit Start Member Parameter Value window opens.
   c. Click the Functions tab.
   d. Click the **Relative Member** list item. With the relative member parameter, you can define the periods that display on the report relative to the period you specify at runtime.
   e. Click the **Add** icon to move the **Relative Member** list item to the Selected area. The Edit Relative Member Function Window opens.
   f. Click in the **Value** field on the **Member** row.
   g. Click the **Lookup** icon. The Edit Parameter Value window opens.
   h. Click the **Current Point of View** list item, so you can enter the starting period for the report.

The following figure shows the Edit Member Parameter Value window for the Accounting Period member. The Current Point of View row is selected.

![Edit Member Parameter Value Window](image)

i. Click the **Add** icon to move the selected value to the Selected area.

j. Click **OK**. The Edit Member Parameter Value window closes.

k. On the Edit Relative Member Function window, select the **Offset** parameter, and enter -11 in the **Value** field. The offset value determines the number of periods to include from the current point of view.
The following figure shows the Edit Relative Member Function window. The Offset parameter is selected and the value entered is -11.

1. Click OK. The Edit Relative Member Function window closes.
2. Click OK. The Edit Start Member Parameter Value window closes.
3. On the Edit Range Function window, click the End Member list item.
4. Click in the Value field and click the Lookup icon. The Edit End Member Parameter Value window opens.
   a. Click the Current Point of View list item.
   b. Click the Add icon to move the value to the Selected area.
   c. Click OK. The Edit End Member Parameter Value window closes.
5. Click OK. The Edit Range Function window closes.
6. Click OK. The Select Members window closes.
7. Save the report and leave it open for the next activity. Optionally preview the report.

Define the Grid Point of View

Define dimensions for the grid point of view. The grid point of view ensures the same initial default value every time for every user.

1. Select the grid.
2. Right-click and select Grid Point of View from the list.
3. On the grid, click the Ledger: User Point of View for Ledger tab. The Select Members window opens.
   a. Expand the Ledger member and continue to expand until you find the ledger to include on the report. Select
      the ledger.
   b. Click the Scenario tab to select the type of balance to use on the report.
   c. Expand the Scenario member and select the Actual list item.
   d. Click the Balance Amount tab.
   e. Expand the Balance Amount member and select the Period Activity list item as the balance amount to
      include on the report.
   f. Click the Currency tab.
   g. Expand the Currency member and select USD from the list.
   h. Click the Currency Type tab.
   i. Expand the Currency Type member and select the Entered list item.
   j. Click OK. The Select Members window closes.

The following figure shows the grid after defining the grid point of view. The grid is selected and the Ledger dimension is set
to the US Primary Ledger. The Accounting Period dimension is set to User Point of View. Column A is defined as a range,
row 1 represents revenue, rows 3 through 5 represent expense accounts, and row 6 represents total expenses.

4. Save the report and leave it open for the next activity.

Set Page and Grid Properties

1. Select the grid.
2. Right-click and select Grid Point of View Setup. The Setup Grid Point of View window opens.
   a. For the Balance Amount dimension, set the Report Viewers May Select option to Nothing, Lock Member Selection. This step prevents the Balance Amount type from being changed at runtime.
   b. Click OK. The Setup Grid Point of View window closes.
3. Set a runtime prompt for the Company dimension to provide the flexibility of selecting any company or combination of companies at runtime.
   a. On the grid, double-click the Pages label. The Select Members window opens.
   b. Click the Remove All icon to deselect the default Company member.
   c. Select the Prompt for Company list item.
   d. Click the Add icon to move the selection to the Selected area.
   e. Click OK. The Define Prompt window opens.
   f. Click the Lookup icon in the Default Member field. The Select Members window opens.
   g. Click the Remove All icon to deselect the default Company member.
   h. Expand the Company member, and continue expanding until you find and select the default companies to display in the prompt.
   i. Click the Add icon to move the companies to the Selected area.
   j. Click OK. The Select Members window closes.
   k. Click the Member Labels in Prompt Selection Dialog list and select the Alias list item. The actual company label displays in the prompt list of values instead of a numeric company value, making the prompt more user-friendly.

The following figure shows the Define Prompts window for the Company dimension. The default members are companies 101 and 102, and the prompt for member labels is set to Alias.

4. On the Grid Properties sheet:
   a. Click the Drill Through option to enable drill through from the report to the detail balances represented on the report.
   b. Click the Suppression list item to view the suppression settings.
   c. Enter 0 in the Zero Values field to suppress the display of zero dollar rows on the report.
The following figure shows the Grid Properties sheet with the **Zero Values** text option set to 0.

5. Click the Pages label on the grid. If the Page Properties sheet doesn’t open, select **Property Sheet** from the **View** menu.
   a. On the Page Properties sheet, click the **Alias**: **Default** option.
6. Click the first cell in row 1. The Heading Row Properties sheet opens.
   a. Click the **Alias**: **Default** option to show the name of the account rather than the account value.
   b. Click the **Allow Expansion** option to enable the expand functionality on the report.
   c. Select the cells for the expense accounts on the grid, and on the Heading Row Properties sheet, select the **Alias**: **Default** and **Allow Expansion** options.
7. Save the report and leave it open for the next activity. Optionally, preview the report.

**Format and Add a Graph**

Insert your company logo, add a report title, and add a chart to the report.

1. On the Designer toolbar, click the **Insert Image** icon.
   a. Drag and drop the cursor over the report to determine the length and width of the image. You can adjust the header height setting on the Report Properties sheet and the grid object, as needed. Keeping the report header narrow improves the PDF output.
   b. Find your company logo in your file system and select it.
2. On the Designer toolbar, click the **Insert Text** icon.
   a. Drag the cursor over the report to determine the length and width of the report title.
   b. Enter a report title.
   c. Select the text, and from the **Format** menu, select **Cell**. The Format window opens.
   d. Set the font style to **Bold** and the size to **14**.
   e. Click **OK**.
   f. On the Designer toolbar, select the **Center Justify** icon to center the text.

3. From the **File**, menu, select **Page Setup**. Click the **Page** tab and set the orientation to **Landscape**.
4. Click **OK**.

The following figure shows the Financial Reporting Studio designer window with a company logo, a report title of Income Statement by Period, and a grid with account rows and an accounting period column.

5. On the Designer toolbar, click the **Insert Chart** icon.
   a. Drag and drop the cursor over the area to determine the length and width of the chart.
   b. On the Chart Properties sheet, select the **Line** chart type and select the expense account rows in the Data Range section.
   c. Click the **Format Chart** button. The Format Chart window opens.
   d. On the Appearance tab, enter a title for the chart.
   e. Click the Legend tab and enter a title for the legend.
   f. Click the Axes tab and enter a title for the primary axis.
   g. Click the Element Style tab and set the attributes for the data sets, as needed.
   h. Click the **Refresh** icon to preview the chart on the Format Chart window.
The following figure shows the Element Style tab on the Format Chart window. The title of the chart is Expenses by Month. The legend is titled Type of Expense. The primary axis is titled Dollars.

1. Click **OK**. The Format Chart window closes.

6. Save the report.

**Run the Report**

You can preview the report in Financial Reporting Studio using the File menu or toolbar, and you can run your report from the Financial Reporting Center.

The following figure shows an example of an income statement report run from the Financial Reporting Center. The report has a logo and title. The grid point of view includes the ledger, scenario, balance amount, currency, and currency type.
dimensions. The company dimension is at the page level. Twelve accounting periods appear as columns and the revenue and expense accounts appear as rows. The chart displays expenses by month.


Configure an Account Group

Configuration of an account group enables you to create self-monitoring accounts that help you eliminate the surprise of account anomalies during your close process.

Scenario

You have been given the task to set up account groups. Follow these steps to define account groups that track key account balances by purpose, category, and comparison criteria.

1. Navigate to the General Accounting Dashboard page.
2. In the Account Monitor section, select View > Account Group > Create. Other Account Group options include:
   - Manage to create, edit, or delete account groups. You can also enable sharing of account groups with other users.
Edit to change an existing account group or to make a copy of an existing account group to which you have access, whether it’s an account group that you own, that’s shared with you, or that’s public. You’re marked as the owner of the copied account group, which is automatically set to private access, but can be changed to the access setting that you like.

3. Enter the account group name and description. The name is used by default on the infolet that the account group displays in, but can be changed using the infolet Actions menu.

4. Select a value for the Display In option to determine if the account group appears in one of the infolets (Allocations, Expenses, Revenues), the Account Monitor, or the Close Monitor. The display option that you select can affect the other account group settings. For example, account groups that display in the Close Monitor must have public access, and account groups that display in infolets must have the option to dynamically derive the ledger enabled.

Note: Regardless of its display setting, any account group can be viewed from within the Account Monitor and Financial Reporting Center.

5. For each infolet and Account Monitor display setting, you can specify a default account group by selecting the Set as default option. The default account group setting is user-specific, determining which account groups appear to you when you view the infolets and the Account Monitor.

Note: The default setting doesn’t affect account groups that are set to display in the Close Monitor. The account group that displays in the Close Monitor is determined by the ledger set definition.

6. Select the Dynamically derive ledger option to apply the account group to any ledger in the same balances cube. The ledger derived is based on your given data access set selection. You must enable this option for account groups that display in the Revenues, Expenses, and Allocations infolets.

Note: If you don’t select this option, enter a ledger on each account row.

7. Select a Time Option and Comparison Option as shown in the following table.

<table>
<thead>
<tr>
<th>Time Option</th>
<th>Comparison Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Period</td>
<td>◦ Budget PTD</td>
</tr>
<tr>
<td></td>
<td>◦ Budget QTD</td>
</tr>
<tr>
<td></td>
<td>◦ Budget YTD</td>
</tr>
<tr>
<td></td>
<td>◦ Prior period PTD</td>
</tr>
<tr>
<td></td>
<td>◦ Prior year PTD</td>
</tr>
<tr>
<td></td>
<td>◦ Prior year QTD</td>
</tr>
<tr>
<td></td>
<td>◦ Prior year YTD</td>
</tr>
<tr>
<td>Quarter</td>
<td>◦ Budget QTD</td>
</tr>
<tr>
<td></td>
<td>◦ Budget YTD</td>
</tr>
<tr>
<td></td>
<td>◦ Prior quarter QTD</td>
</tr>
<tr>
<td></td>
<td>◦ Prior year QTD</td>
</tr>
<tr>
<td></td>
<td>◦ Prior year YTD</td>
</tr>
<tr>
<td>Year</td>
<td>◦ Budget YTD</td>
</tr>
<tr>
<td>Time Option</td>
<td>Comparison Option</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>Prior year YTD</td>
</tr>
</tbody>
</table>

**Tip:** If you’re using a budget comparison option, select the budget name in the **Scenario** field.

8. **Set the access.**

**Note:** Regardless of the access setting, only the person who owns the account group can modify it. However, for account groups that you have access to, you can share with others even if you’re not the owner.

- **Private:** For your use only.
- **Public:** For use by all users who have access to the same balance cube of that account group. Account groups that display in the Close Monitor must be set to **Public**.
- **Shared:** For use by users you specify and who have access to the same balance cube of that account group.

**Note:** To set shared access, navigate to the **Manage Account Group** page.

9. In the **Accounts** section, enter the accounts to monitor. The accounts must be defined to be consistent with the particular infolets targeted to track revenues, expenses, or allocations pools.

- Accounts included in an account group for display in the Expenses infolet must be of the account type Expense.
- Accounts included in an account group for display in the Revenues infolet must be of the account type Revenue.
- Close Monitor account groups must only have two account rows. The first row must represent total revenues and the second row must represent total expenses.

**a.** Give each account a short name that is easily recognizable. The name displays in infolets and in the **Name** column of the Account Monitor. For account groups that display in infolets, you must provide a name for each account.

**b.** If the **Dynamically Derive Ledger** option isn’t enabled, you must enter a ledger.

**c.** Enter either parent or child values for each segment of the account.

**d.** Select when to display the account in the **Change** field.

- Always Display
- Decrease by Less than Amount
- Decrease by Less than Percentage
- Decrease by More than Amount
- Increase by More than Amount
- Increase by Less than Amount
- Increase by Less than Percentage
- Increase by More than Percentage
- Decrease by More than Percentage
- Not Equal
- Equal

**e.** Enter a value in the **Threshold** field, which is the criteria that’s being measured against. The threshold is used in conjunction with the **Change** field selection.
10. Click **Save and Close** or **Save and Create Another**.

**Related Topics**
- Account Groups

**FAQs**

**How can I apply permissions to objects from Financial Reporting in Workspace?**

Open the **Permission** dialog box from the **Tasks** list to set permissions for a catalog object. Permissions determine which user, group, or role can view, open, or modify the object. If you display this dialog box while working in the catalog in **Workspace**, any permission changes that you specify are applied immediately. If you display this dialog box as part of the **Batch Scheduler** wizard, then the permission changes are not applied until you run the batch.

**How can I store and edit Financial Reporting objects?**

First installed Oracle BI EE as part of Oracle Fusion Applications. Then store and edit new objects that you create for Oracle Hyperion Financial Reporting in **Workspace** in the Oracle BI Presentation Catalog. Perform operations on those objects in the catalog similarly to how you work with other objects, such as copying and modifying properties. See the documentation for Hyperion Financial Reporting for complete information on working with objects. Financial Reporting report designers can also access the Financial Reporting objects in the Financial Reporting Studio.

**How can I migrate Financial Reports from one environment to another?**

You can export your financial reports from a source environment and import them to a target environment using implementation projects.

Only the financial reports in the /shared/Custom/Financials folder are exported, so make sure to copy all the financial reports, or the folders containing them, to this folder. In the Setup and Maintenance work area, create an implementation project that includes only the **Create Financial Statements** task. Then use the **Manage Configuration Packages** task to export and import the reports.

**Note:** For the Financial Reporting report definition migration service, from a source to a target environment, references to version IDs of dimension members hierarchies are synchronized to their version IDs in the target environment.

**Related Topics**
- How You Use Implementation Projects to Manage Setup
- Setup Data Export and Import Using Implementation Project
- Exporting Setup Data Using Implementation Project: Procedure
• Importing Setup Data Using Implementation Project: Procedure
Glossary

**analysis**
A selection of data displayed in one or more views, such as a table or chart, to provide answers to business questions.

**analytics**
Business intelligence objects such as analyses and dashboards that provide meaningful data to help with decision making.

**business intelligence catalog**
The repository where all business intelligence objects, including analyses, reports, briefing books, and agents, are stored. The catalog contains separate folders for personal, shared, and modified objects.

**business intelligence repository**
The metadata that determines all of the columns, or pieces of data, that you can include in analytics. You can also use the repository as a source of data for reports.

**cube**
A block of data that contains three or more dimensions. An Essbase database is a cube.

**dashboard**
A page that provides quick access to key tasks and summary information for various objects within a functional area of interest.

**dashboard**
A collection of analyses and other content, presented on one or more pages to help users achieve specific business goals. Each page is a separate tab within the dashboard.

**data model**
The metadata that determines where data for a report comes from and how that data is retrieved.

**EDI**
Abbreviation for electronic data interchange.

**EFT**
Acronym for Electronic Funds Transfer. A direct transfer of money from one account to another, such as an electronic payment of an amount owed a supplier by transferring money from a payer’s disbursement bank account into the supplier’s bank account.
flexfield
A flexible data field that you can configure such that it contains one or more segments or stores additional information. Each segment has a value and a meaning.

flexfield segment
An extensible data field that represents an attribute and captures a value corresponding to a predefined, single extension column in the database. A segment appears globally or based on a context of other captured information.

infolet
A small, interactive widget on the home page that provides key information and actions for a specific area, for example social networking or your personal profile. Each infolet can have multiple views.

job definition
The metadata that determines what a job does and what options are available to users when they submit the scheduled process. A job is the executable for a scheduled process.

panel tab
A tab that provides supplemental information or functionality for the page. Each panel tab is on the right side of the page, has an icon as the tab label, and slides out when you open the tab.

prompt
A parameter that you set when you use analytics, limiting the data in the analysis or in all analyses on the dashboard or dashboard page (tab).

report
An output of select data in a predefined format that's optimized for printing.

role
Controls access to application functions and data.

scheduled process
A program that you run to process data and, in some cases, generate output as a report.

Style template
An .rtf template containing style information that's applied to report layout templates to achieve a consistent look and feel across reports.
subject area
A set of columns, or pieces of data, related to a specific business object or area.

Subtemplate
An .rtf or .xsl format that is defined once and used multiple times within a single report layout template or across multiple layout template files.

view
A specific way to present the results of an analysis, for example as a table or graph. Other types of views, such as the title view, show other components of the analysis.

work area
A set of pages containing the tasks, searches, and other content you need to accomplish a business goal.

workflow
An automated process that passes a task from one user (or group of users) to another to view or act on. The task is routed in a logical sequence to achieve an end result.